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WARNING

Make sure you download any pictures from your camera BEFORE removing
or changing batteries, unless you have been using an SD card rather than the
internal memory for photo storage. We recommend you download all current
photo files for safekeeping before storing the ImageView away if you are not
using an SD card in the camera, in case the batteries become depleted during
extended storage.

WARNING

Do NOT look directly at the sun through your binoculars.
Doing so may cause permanent eye damage.

NOTE: To reset the camera if you experience problems or if the display becomes
unresponsive, remove the batteries for at least one minute, then re-install them.
This may result in the loss of all photos/videos stored in the internal memory.



ENGLISH

Congratulations on your purchase of the Bushnell ImageView®
binocular! The Bushnell ImageView binocular takes the technology
of digital photography and combines it with a high-quality compact
binocular. This allows you to observe sporting events, wildlife, scenic
vistas or anything you would normally use a binocular for, and then
save the image in a built-in attached digital camera. You can then
download these images to your computer and e-mail them to your
friends and family, print out the picture using the included software or
save them in a photo album for future use. Before using the product,
please read the instructions contained in this manual and take time
to familiarize yourself with the different parts and features of the

product.
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Setup and Basic Operation

1.The camera is powered by two AAA alkaline, lithium, or NiMh batteries (not included). Insert batteries
into the compartment, with the springs in contact with the negative (flat) end of each battery. A power
meter on the left center of the display indicates battery condition.

2. Insert an SD card ("upside down" with metal contacts facing up) in the slot if greater storage is desired.
You may use SD cards (not MMC cards) up to 1 GB capacity. The camera has 8 MB of internal memory
which can hold over 100 photos, so a card is not necessary. However, the internal memory contents will be
lost if the batteries are removed or die-unlike photos stored on an SD memory card. A 256 MB standard
speed SD card is available in most consumer electronics or computer stores and a is good choice for your
ImageView.

3. Press and hold the MODE button until the camera turns on. The camera will turn off automatically after
about one minute if no buttons are pressed. Note: when the camera is connected to a computer via the supplied
USB cable, the camera will power on automatically, and draw power from the computer with no battery drain.

4. Hold the ImageView steady and press SNAP to take a picture (or start/stop shooting a video, when the
camera is in video mode). The camera focus is preset to take sharp photos from appoximately 35 feet to

infinity.

5. When using a tripod, you can help avoid the effects of camera shake by plugging the supplied remote
shutter release into the jack next to the SD card slot, and using the button on the remote rather than SNAP
to take photos.



Using the Operational Modes/Setting Date & Time

‘The ImageView will imprint the date and time in the bottom right corner of your photos. To
set the current date and time, after turning on the camera, press and hold both the MODE and
SNAP buttons at the same time, until the display begins to flash. The display now shows the
last two digits of the year. Press the MODE button to move the cursor to the second digit if
necessary. Press the SNAP button to advance the digit to the current year ("07" for 2007, etc).
Then press MODE to go to the next number, which is the month. Again, use SNAP to change
this to the current month. Following the month display is: date, hour (24hr format), minute,
and second-continue to set these following the same process using the MODE and then SNAP
buttons. When you have completed all of the date/time settings, the display will stop flashing
and return to normal. Note that you will need to reset the date/time after replacing batteries.

Your ImageView is already set to high resolution and quality right out of the box, and it is
not necessary to use the MODE settings and make any changes to get good results by simply
pressing the SNAP button to take photos. However, as you might want to shoot a video clip,
delete one or more previous photos, or explore other options, we recommend you review the
available mode options listed on the following pages. Briefly pressing the MODE button will
step through these operational modes in the listed order, and you will see the icon for each
mode along with its current setting on the display. Use the SNAP button to select the desired
setting for any mode. If you make no changes, and the SNAP or MODE button is not pressed
within 5 seconds, the camera will return to normal operation and display.



Using the Operational Modes (Bold indicates default settings)

pixels), Low

(320x240 pixels)

Mode Icon Settings Description
Video Video OFF, High Select "Hi" (recommended) or "Lo" video resolution
Camera (640x480 pixels instead of "OFF" to put the camera in video mode.
per frame, 15 fps), | Wait a few seconds for the camera to automatically
Low (320x240 return to the normal display, then begin shooting by
pixels) pressing SNAP. The counter will show elapsed time-
up to the 53 (Hi) or 132 (Lo) second maximum for
each video clip. Press SNAP again to stop shooting.
The counter will advance by one, indicating the
video file has been saved. Return to the video mode
setting and select OFF to reset the camera to still

photo mode.

Quality HqorLq High, Low Select "Hi" (recommended) or "Lo" quality to
choose the amount of file compression, which affects
the size of the photo file. "Lo" allows more photos
to be stored in memory, but at reduced quality.

Resolution Hior Lo High (640x480 Select "Hi" (recommended) or "Lo" resolution,

based on your preference for better looking photos
(Hi) or being able to take a greater number of

photos (Lo).
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Using the Operational Modes

photo or video

Mode Icon Settings Description
Line Frequency | 60 or 50 60 Hz, 50 Hz Set to match the AC power frequency (cycles) of
your country. This ensures that stills and videos shot
under fluorescent lighting appear normal.
Continuous CT OFF, 3, 5 Select 3 or 5 frames to shoot a rapid series of photos
instead of a single frame when SNAP is pressed
(in normal still photo mode). To cancel, enter this
mode again and select OFE
Memory Access | MEM Sto (USB Mass Select "Sto" to access the internal or card memory
Storage), PC (USB | when the camera is connected to a computer with
Camera) the USB cable. "PC" allows the camera to be
used as a live USB/PC camera (note that the 8x
magnification and lack of close focus capability
limits usefulness in most size rooms)
Delete Last LSt+Trash None-press SNAP | Select this mode and press SNAP to delete only the
Can to delete the last last photo or video you took. The counter will go

down one number.
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Using the Operational Modes

Mode Icon Settings Description
Delete All ALL+Trash | None-press SNAP | Select this mode and press SNAP to erase the entire
Can to delete all photo | memory contents (the counter resets to zero).
and video files Use this after downloading your files, to clear the
memory so you can take new photos. If "Delete All"
is selected accidently, simply wait a few seconds and
the camera will return to normal operation.
Format FOr+Trash | None-press SNAP | If you are using a new SD card, or one previously
Can to format card or used in other devices, we recommend you select
internal memory Format and press SNAP before you start taking
photos, to the card is setup with the correct data file
system for this camera. Note that formatting a card
erases its contents-please be sure you have backed up
any previous files first.
Self-Timer Clock OFF or On Photo is taken after a 10 second delay when SNAP

is pressed (in normal still photo mode.) This can be
used to avoid accidently shaking the camera when
the SNAP button is pressed. If the remote shutter
cable is available, it should be used instead of the
self timer when the camera is tripod mounted. The

timer automatically cancels after use.
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USING THE IMAGEVIEW WITH YOUR COMPUTER:

1. The camera will be recognized as a USB mass storage device (if it is set to "STO" and not "PC"),
which means no special drivers are required for all operating systems later than Windows 98 (Me,
2000, XP) Mac OS 9 and OSX are also compatible. If you have a PC running Windows 98,
you must install the driver found on the included CD-ROM BEFORE CONNECTING THE
CAMERA TO YOUR PC.

2. If you have a computer OS as listed above that is USB mass storage compliant, a new disc icon will
appear in Windows Explorer (under “My Computer”) as a new “Removable Disc” after plugging in
the USB cable from the Imageview. Mac users will see the new disc device appear on their desktop.
Clicking on the new disc icon will show the contents, a folder named “DCIM.” The image folder
inside this contains your photos, stored as JPEGs (.jpg file format). They may then be opened,
edited, renamed and saved using any photo or graphics software that accepts .jpg files. If you do not
have software that will open .jpg files, you should install MGI Photosuite (Windows only) from the
included CD-ROM. See “Software Installation” for instructions.

3. After you have copied or opened and saved the photo files to your computers hard drive, you
may disconnect the Imageview camera (NEVER disconnect the camera while files are still being
transferred to your computer.) Before disconnecting, you should “cject” or stop the removable disc

representing the camera to avoid an error message (not necessary with Windows XP).

4. See the following pages for full step by step instructions to download your photos.
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System Requirements (Minimum)

OS: Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® III 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)

SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color

200 MB available hard disk space (if installing PhotoSuite)

Internal USB Port

Software Installation

If you are using Windows 98, you must install drivers before connecting the camera to your PC. Insert the CD-ROM
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “Install Driver”, then
follow the directions. After installation, restart your computer. Windows 2000, ME, and XP do not require drivers,
as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were stored on
an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer, you may
install Roxio PhotoSuite® from the CD-ROM. Be sure to read the “Release Notes” completely, noting any tips or
potential issues relevant to your PC configuration and OS.

WARNING: Make sure you download any picture from your camera before you remove the
batteries from the camera.

Transferring The Photos & Videos to Your PC - Step by Step

1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Connect the supplied cable to the ImageView’s USB port, then directly to a main USB port on your computer-do
not use front panel/keyboard USB ports or unpowered “hubs”.
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Transferring The Photos & Videos to Your PC continued

3. The LCD display will indicate “STO”, and the ImageView will be recognized as a standard “USB
Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your
hard drive, just as if they were stored on an external hard drive or a CD-ROM.

4. (This step is not required with Windows X, simply use the options in the pop-up window to view, copy
or edit your photos). Open My Computer or Windows Explorer. The camera will be seen as a new
“Removable Disk” with an unused drive letter assigned to it. Double click this new “Disk” icon, open
the “DCIM” folder inside, then the folder(s) inside that (“100MEDIA” ,etc). Your photos/videos are
the files inside-they have the prefix “IMG__" followed by a number, same as seen earlier on the camera’s
display when you review photos. Single clicking any file should show a small preview image.

5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then
“Edit>Copy to Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My
Pictures”, or create a new folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the
photo files you want.

6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000
may produce a screen warning that you have disconnected a USB device without stopping or ejecting
the “disk” first (your photo files will not be harmed). If so, check the box that adds an icon to your
system tray or taskbar. Then next time you finish transferring photos, you can click that icon first, and
“Stop the USB Mass Storage Device” before disconnecting the camera. (On Mac computers, you should
‘eject” the “disk” that appeared on your desktop when the camera was connected.)
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Transferring The Photos & Videos to Your PC continued

7. You're now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder
where you stored the photos earlier. If you are using PhotoSuite, select File>Open Photo, then use the “Look in”
pull down menu at the top of the Open window, select “My Computer”, select your hard drive, and double click
any photo in the folder where you copied the files from the camera. It is also possible to open and work with your
photos directly from the ImageView while it is still connected.To do this with PhotoSuite, first follow steps 1-3,
then open PhotoSuite, select File>Open Photo and use the “Look in” menu to select My Computer, then select
the “Removable Disk”, and open the folders inside until you get to the JPEG photo files. If you choose to work
this way, from a connected camera, be sure that you save the photo (when you are done editing) to your hard drive,
and not the camera’s memory or card. To do this in PhotoSuite, after clicking “Done”, answer “Save Changes?”
with “Yes”, but then answer “Replace Existing File”? with “No” and use the “Save As” dialog box to save the edited
photo in a folder on your hard drive (“Save In>Local Disk”), not the “Removable Disk” (camera).

8. If you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color
of your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium
resolution version for email or inserting into documents. When you are ready to save your edited file, you may
want to use “Save As” and give it a more descriptive name than “IMG___". Doing this also preserves the original
file as a backup to reopen and re-edit later. Make sure you have successfully transferred all the photos you wanted
to save before using “Delete All” on your camera to make room for new images.
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BINOCULAR INSTRUCTIONS

Your Bushnell binocular is a precision instrument designed to provide many years of pleasurable
viewing. This portion of the booklet will help you achieve optimum performance by explaining how
you can adjust the binocular to your eyes, and how to care for this instrument. Read the instructions
carefully before using your binocular.

EYE ADJUSTMENTS (Figure 1)

How to Adjust For Distance Between Your Eyes

The distance between the eyes, called “interpupillary distance,” varies from
pCrSOn to person. TO aChiCVC perfect alignmcnt Of lCnS to CYC) fOHOW theSC

slmple steps. INTERPUPILLARY DISTANCE

1. Hold your binocular in the normal viewing position.
2. Grasp each barrel firmly. Move the barrels closer together or further apart
until you see a single circular field. Always re-set your binocular to this position before using.

How to Adjust For Individual Eye Strength
As individual eyesight varies from one person to another, most Bushnell binoculars have a diopter setting

feature which allows you to fine-tune the binocular to your vision. Follow the focusing instructions below
for your type of binocular.
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FOCUSING

1.

2.
3.
4

EYECUPS (Figure 3)

Your Bushnell binocular is fitted with rubber roll-down eyecups designed for
your comfort and to exclude extraneous light. If you wear sun/eyeglasses, roll
down the eyecups. This will bring your eyes closer to the binocular lens thus

Adjust interpupillary distance. (Figure 1)
Set the “diopter setting” (Figure 2) to zero and view a distant object.
Keep both eyes open at all times.

Using a lens cover or your hand, cover the objective (front) lens of the —;;f,—.mmm_,-
—— e S —
same side of the binocular that has the “diopter setting.” This is usually [ d

DIOPTER SETTING

the right side. (The left side on zoom models.)
Using the center focus wheel, focus on a distant object with fine detail

(e.g., brick wall, tree branches, etc.) until it appears as sharp as possible.

Uncover the objective lens on the diopter side, cover the other objective lens, then view the same object.
Using the “diopter setting” adjustment ring, focus the same object being viewed. Caution should
be used as over turning or forcing the diopter eyepiece can cause damage or cause the eyepiece to
break away from the chassis.

Your binocular should be adjusted for your eyes. Focus at any far or near distances can now be
attained simply by turning the center focus wheel. Make a note of the diopter setting for your eyes
for future reference.

providing improved field of view. UL

e
ROLL-DOWN EYECUPS
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INSTRUCTIONS FOR CARE OF BINOCULARS

Your Bushnell binocular will provide years of trouble-free service if it receives the normal care you would

give any fine optical instrument. The Imageview is not waterproof, and should not be exposed to any
source of moisture. Water damage is not covered by the warranty.

1.

DAl

If your binocular has roll-down, flexible eyecups, store it with the eyecups up. This avoids excessive
stress and wear on the eyecups in the down position.

Avoid banging and dropping.

Store in a cool, dry place.

WARNING: Looking directly at the sun with your binocular can cause permanent eye damage.
Never expose your ImageView binocular to any type of excessive liquid or fluid, as it is not water/
fogproof.

Take the batteries out of your ImageView if you are not going to use it for a long period of time. (Make
sure you download any pictures from your camera before you remove the batteries out of the camera.)

CLEANING

1.
2.

Blow away any dust or debris on the lens (or use a soft lens brush.)

To remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular motion. Use of
a coarse cloth or unnecessary rubbing may scratch the lens surface and eventually cause permanent
damage. A “microfiber” cleaning cloth (available at most photo dealers) is ideal for the routine
cleaning of your optics.

For a more thorough cleaning, photographic lens tissue and photographic-type lens cleaning fluid
or isopropyl alcohol may be used. Always apply the fluid to the cleaning cloth — never directly on
the lens.
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TWO-YEAR LIMITED WARRANTY

Your Bushnell product is wartanted to be free of defecs in mateials and workmanship for two years after [This equipment has been tested and found to comph
the date of purchase. In the event of a defect under this warranty, we will, at our option, repair or replace
the product, provided that you return the product postage prepaid. This warranty does not cover damages
caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell

Authorized Service Department.

Any return made under this warranty must be accompanied by the items listed below:

)
) Name and address for product return
) An explanation of the defect

) Proof of Date Purchased

)

(O

A check/money order in the amount of §10.00 to cover the cost of postage and handling

Product should be well packed in a sturdy outside shipping carton, to prevent

damage in transit, with return postage prepaid to the address listed below:

INUSA. Send To: IN CANADA Send To:

Bushnell Outdoor Products
Aun.: Repairs

8500 Marshall Drive
Lenexa, Kansas 66214

Bushnell Performance Optics
Aun.: Repairs

25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable
warranty information. In Europe you may also contact Bushnell at:

BUSHNELL Performance Optics Gmbh
European Service Centre
MORSESTRASSE 4

D- 50769 KOLN

GERMANY

Tel: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

‘This warranty gives you specific legal rights.
You may have other rights which vary from country to country.
©2006 Bushnell Outdoor Products

CC Note:

ith the limits for a Class B digital device, pursuant
Jto Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful
interference in a residential installation. This equipment
lgencrates, uses and can radiate radio frequency encrgyl
land, if not installed and used in accordance with the
linstructions, may cause harmful interference to radi
communications. However, there is no guarantee that
interference will not occur in a particular installation. I
[this equipment does cause harmful interference to radi
r television reception, which can be determined by
turning the equipment off and on, the user is encouraged|
lto try to correct the interference by one or more of th
ollowing measures:

| Reorient or relocate the receiving antenna.
| Increase the separation between the equipment and receiver,
| Connect the equipment into an outlet on a circuil
different from that to which the receiver is connected.
| Consult the dealer or an experienced radio/TV|
technician for help.

[The shielded interface cable must be used with the
lequipment in order to comply with the limits for a digital
\device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change without
lany notice or obligation on the part of the manufacturer,

€
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AVERTISSEMENT

AVANT de retirer ou de changer les piles, veillez a télécharger les photos de votre
appareil, 2 moins que vous n'ayez utilisé une carte SD plutét qu'une mémoire
interne pour stocker vos photos. Si vous n’utilisez pas de carte SD dans I'appareil
ImageView, nous vous conseillons, avant de le ranger, de télécharger tous les
fichiers photos en cours pour les conserver, afin d’éviter que les piles ne se
déchargent durant un stockage prolongé.

AVERTISSEMENT

NE REGARDEZ PAS directement le soleil 4 travers vos jumelles.
Cela pourrait causer des lésions oculaires permanentes.

REMARQUE: Pour réinitialiser votre appareil photo si vous rencontrez des
problémes ou si affichage ne réagit pas, retirez les piles pendant au moins une

minute, puis remettez-les en place. Cela peut causer la perte de toutes les photos /
vidéos stockées dans la mémoire interne.
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FRANGAIS

Félicitations pour votre achat de jumelles Bushnell ImageView™ ! Les
jumelles Bushnell ImageView combinent la technologie de la photo
numérique avec des jumelles compactes de haute qualité.

Vous pouvez ainsi observer des événements sportifs, des animaux
sauvages, des panoramas magnifiques, ou tout ce que vous observez
normalement avec des jumelles, puis sauvegarder I'image dans un
appareil photo numérique intégré. Vous pouvez ensuite télécharger
ces images sur votre ordinateur et les envoyer par courriel a vos amis
et vos parents, imprimer les images a I'aide du logiciel inclus ou les
sauvegarder dans un album photo pour usage ultérieur.

Avant d’utiliser le produit, veuillez lire les instructions contenues dans
ce manuel et prendre le temps de vous familiariser avec les différentes

parties et fonctions de I'appareil.
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Guide des pieces de 'appareil photo

et des jumelles

Jack de Fente pour Port
télécommande ;e USB

Douille pour
trépied

Compartiment des

Mise au point Bouton Bouton piles
des jumelles « Snap » Lenttille de de mode (Glissez dans le sens
Iappareil 3 de la fleche pour
photo ouvrir)
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Configuration et principes de fonctionnement

1. Lappareil fonctionne 4 I'aide deux piles alcalines AAA au lithium ou NiMh (non incluses). Insérez les
piles dans le compartiment, ressorts en contact avec I'extrémité négative (plate) de chaque pile. Un wattmetre
situé au centre gauche de I'affichage indique I'état de la pile.

2. Insérez une carte SD («a I'envers », contacts métalliques dirigés vers le haut) dans la fente si vous souhaitez
une plus grande capacité de stockage.

Vous pouvez utiliser des cartes SD (et non des cartes MMC) d’une capacité maximale de 1 Go. Lappareil
photo dispose d’une mémoire interne de 8 Mo, capable de contenir plus de 100 photos, de sorte qu'une
carte n'est pas nécessaire. Toutefois, le contenu de la mémoire interne est perdu si les piles sont retirées ou si
elles s'épuisent, contrairement au contenu stocké sur une carte mémoire SD.

Des cartes SD standard de 256 Mo sont en vente dans la plupart des magasins d’électronique ou d’ordinateurs
et sont le choix idéal pour votre ImageView.

3. Appuyez sur le bouton MODE sans le relicher jusqu'a ce que I'appareil photo sactive. Lappareil se
désactive automatiquement au bout d’environ une minute si vous n'appuyez sur aucun bouton. Remarque
: lorsque l'appareil est relié¢ & un ordinateur via le cable USB fourni, il s'active automatiquement et est
alimenté par |'ordinateur, ce qui évite d’épuiser la pile.

4. Tenez I'TmageView immobile et appuyez sur SNAP pour prendre une photo (ou commencer/arréter de
filmer une vidéo, lorsque l'appareil est en mode vidéo).

La mise au point de 'appareil est préréglée de maniére a prendre des photos nettes depuis des distances de
11 meétres (35 pieds) a I'infini.

5. Si vous utilisez un trépied, vous pouvez minimiser les effets des vibrations de I'appareil en branchant le
déclencheur a télécommande fourni

dans le jack situé a coté de la fente A carte SD, et en utilisant le bouton de la télécommande plutdt que le

bouton SNAP pour prendre des photos.
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Utilisation des modes opératoires / réglage de la date et de 'heure

LImageView indique la date et 'heure dans le coin inférieur droit de vos photos. Pour régler la date et
I’heure en cours, activez I'appareil photo, puis appuyez en méme temps sur les boutons MODE et SNAP
sans les relicher, jusqu’a ce que I'affichage commence  clignoter. Laffichage indique alors les deux derniers
chiffres de 'année. Appuyez sur le bouton MODE pour amener le curseur au deuxiéme chiffre si nécessaire.
Appuyez sur le bouton SNAP pour avancer le chiffre jusqu’a 'année en cours (« 07 » pour 2007, etc.).
Appuyez ensuite sur MODE pour passer au nombre suivant, c’est-a-dire le mois. Appuyez 4 nouveau sur
SNAP pour afficher le mois en cours. Aprés le mois viennent : la date, 'heure (échelle de 24 heures), les
minutes et secondes. Continuez 2 les régler de la méme maniére, en utilisant les boutons MODE, puis
SNAP. Une fois tous les réglages de date et d’heure terminés, 'affichage cesse de clignoter et revient a son
état normal. A noter : vous devrez procéder 3 nouveau au réglage de la date et de Iheure aprés avoir remplacé
les piles.

Votre ImageView est déja réglé pour haute résolution et qualité au départ d’usine. Il n’est donc pas nécessaire
d’utiliser les réglages MODE et de changer quoi que ce soit pour obtenir de bons résultats. Il suffic d’appuyer
sur le bouton SNAP pour prendre des photos. Toutefois, si vous souhaitez filmer un clip vidéo, effacer une
ou plusieurs des photos précédentes, ou explorer d'autres options, nous vous conseillons d'étudier les options
disponibles décrites dans les pages suivantes. Appuyez bri¢vement sur le bouton MODE pour passer de 'un
4 l'autre de ces modes opératoires dans 'ordre indiqué, et vous verrez s'afficher I'icone avec le réglage actuel
correspondant a chaque mode. Utilisez le bouton SNAP pour sélectionner le réglage souhaité correspondant
4 chaque mode. Si vous ne faites aucun changement et n’utilisez pas le bouton SNAP ou MODE dans les 5
secondes, I'appareil photo reprend le fonctionnement normal et I'affichage normal.
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Utilisation des modes opératoires (Gras indique les réglages par défaur)

pixels), Faible
(320x240 pixels)

Mode Icone Réglages Description
Vidéo Caméra ARRET, Haut Sélectionnezla résolution vidéo “Hi” (recommandée)
vidéo (640x480 pixels ou “Lo”au lieu de “ARRET” pour mettre I'appareil
par image, 15 en mode vidéo.Attendez quelques secondes que
fps [images par lappareil revienne automatiquementd laffichage
seconde]) Bas normal, puis commencez 4 filmer en appuyant sur
(320x240 pixels) SNAP. Le compteur affiche le temps écoulé, jusqu’au
maximum de 53 secondes (Hi.) ou 132 secondes
(Lo) pour chaque clip vidéo. Appuyez sur SNAP
pour arréter de filmer. Le compteur avance d’un
cran, indiquant que le fichier vidéo a été sauvegardé.
Revenez au mode vidéo et sélectionnez OFF pour
réinitialiser 'appareil pour le mode photo fixe.
Qualité Qualité Haute, Basse Sélectionnez la qualité “Hi” (recommandée) ou
HqoulLq “Lo” pour choisir le degré de compression de fichier,
ce qui affecte la taille du fichier photo. “Lo” permet
de stocker davantage de photos en mémoire, mais
cela, au détriment de la qualicé.
Résolution Hiou Lo Haute (640x480 Sélectionnez la résolution “Hi” (recommandée) ou

“Lo” en fonction de vos préférences pour obtenir de
plus belles photos

(Hi) ou pour pouvoir prendre un plus grand nom-
bre de photos (Lo).
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Utilisation des modes opératoires

photo ou vidéo.

Mode Icone Réglages Description

Fréquence 60 ou 50 60 Hz, 50 Hz Réglée pour correspondre 2 la fréquence CA (cycles)
de votre pays. Cela garantit que les photos fixes et
les vidéos prises sous éclairage fluorescent apparais-
sent normales.

Continu CT ARRET, 3, 5 Sélectionnez 3 ou 5 images pour prendre une série
rapide de photos au lieu d’une seule image lorsque
vous appuyez sur SNAP (en mode photo fixe nor-
mal). Pour annuler, entrez 3 nouveau dans ce mode
et sélectionnez OFF (arrét).

Accés mémoire | MEM Sto (mémoire de Sélectionnez « Sto » pour accéder a la mémoire

masse USB). PC interne ou la carte mémoire lorsque I'appareil est

(appareil photo reli¢ a un ordinateuravec le cible USB. « PC »

USB) permet d’utiliser I'appareil comme appareil photo
USB/PC actif (il est a noter que le grossissement 8x
et le manque de capacité limitée de mise au point
sur une courte distance limite son utilité dans la
plupart des picces)

Effacer la LSt + Aucune — appuyez | Sélectionnez ce mode et appuyez sur SNAP pour ef-

derniére (photo | poubelle sur SNAP pour facer seulement la derniere photo ou vidéo que vous

ou vidéo) effacer la derniére avez prise. Le compteur baisse d’un chiffre.
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Utilisation des modes opératoires

Mode Icone Réglages Description
Effacer toutes ALL + Aucune — appuyez | Sélectionnez ce mode et appuyez sur SNAP pour ef-
(les photos ou poubelle sur SNAP pour facer tout le contenu de la mémoire (le compteur se
vidéos) effacer tous les remet 2 zéro). Ne faites cela qu'apres avoir téléchar-
fichiers photos ou | gé vos fichiers, pour vider la mémoire et pouvoir
vidéos. prendre de nouvelles photos. Si « Effacer toutes »
est sélectionné accidentellement, il suffit d’attendre
quelques secondes et I'appareil reprendra son fonc-
tionnement normal.
Formatage FOr + Aucun — appuyez Si vous utilisez une nouvelle carte SD ou une carte
poubelle sur SNAP pour déja utilisée dans d'autres appareils, nous vous con-
formater la carte seillons de sélectionner. Formatage et d’appuyer sur
ou la mémoire SNAP avant de commencer a prendre des photos,
interne. afin que la carte soit configurée avec les fichiers de
données corrects pour cet appareil. 7/ est i noter que
le formatage d’une carte efface son contenn. Assurez-
vous que vous avez sauvegardé les fichiers précédents.
Retardateur Horloge ARRET ou La photo est prise avec un retard de 10 secondes lorsque
marche vous appuyez sur SNAP (en mode photo fixe normal).

Cette caractéristique peut servir  éviter toute vibration
accidentelle de I'appareil lorsque vous appuyez sur le bou-
ton SNAP. Si vous disposez du cible de télécommande
de déclencheur, utilisez-le au lieu du retardateur lorsque
lappareil est monté sur un trépied. Le retardateur s'annule
automatiquement aprés usage.
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UTILISATION DE L'IMAGEVIEW AVEC VOTRE ORDINATEUR :

1. Lappareil photo est reconnu comme appareil & mémoire de masse USB (s'il est réglé sur « STO » et non sur
« PC »),ce qui signifie qu'aucun programme d’essai spécial n'est requis pour tous les systmes d’exploitation
postérieurs 2 Windows 98 (Me, 2000, XP). Max OS 9 et OSX sont également compatibles. Si votre ordinateur
utilise Windows 98, vous devez installer le programme d’essai se trouvant sur le CD-ROM inclus, AVANT DE
RELIER CAPPAREIL PHOTO A VOTRE ORDINATEUR.

2. Si vous disposez d’un programme d’exploitation (indiqué dans la liste ci-dessus) compatible avec la mémoire de
masse USB, une fois que vous avez branché le cable USB venant de votre ImageView, une nouvelle icone de
disque apparait dans Windows Explorer en tant que « Disque amovible » (sous la rubrique « My Computer »).
Les utilisateurs d’ordinateurs Mac verront le nouveau disque apparaitre sur leur surface de bureau.

Cliquez sur la nouvelle icéne de disque pour afficher le contenu, un dossier intitulé « DCIM ». Le dossier d’images
A lintérieur contient vos photos, stockées en tant que JPEG (format fichier .jpg). Ces fichiers peuvent étre
ouverts, modifiés, renommés et sauvegardés a I'aide de n'importe logiciel photos ou graphiques acceptant les
fichiers .jpg. En I'absence d’un logiciel capable d’ouvrir des fichiers .jpg, vous devez installer MGI Photosuite
(Windows uniquement) se trouvant dans le CD-ROM inclus. Consultez les instructions dans la section «
Installation de logiciels ».

3. Aprés avoir copié ou ouvert et sauvegardé les fichiers photos sur le disque dur de votre ordinateur, vous pouvez
débrancher I'appareil ImageView. (NE débranchez JAMAIS I'appareil durant le transfert de fichiers vers votre
ordinateur.) Avant de débrancher, vous devez “¢jecter » ou stopper le disque amovible représentant I'appareil
pour éviter tout message d’erreur (ce qui w'est pas nécessaire avec Windows XP).

4. Consultez les instructions étape par étape dans les pages suivantes pour télécharger vos photos.
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Configuration nécessaire (Minimum)

Systeme d’exploitation : Windows® 98/98SE/2000/ME/XP

Unité centrale : Equivalente ou supérieure 3 MMX Pentium® 200MHZ (Pentium® III 500 MHz pour
PhotoSuite5™)

Mémoire : 32 Mo minimum (64 Mo recommandés pour Photosuite), carte vidéo SVGA avec VRAM 2 Mo, affichage
écran 800x600, couleur trés visible 16 bits 200 MB d’espace disponible sur disque dur (en cas d’installation de
PhotoSuite), Port USB interne

Installation de logiciels

Si vous utilisez Windows 98, vous devez installer des programmes d’essai avant de relier votre appareil photo  votre ordinateur. In-
sérez le CD-ROM dans le lecteur CD de votre ordinateur ; il s'exécute automatiquement et I'écran d'installation s'affiche. Sélectionnez
«Install Driver » (installer programme d’essai), et suivez les instructions. Apres I'installation, redémarrez votre ordinateur. Windows
2000, ME, et XP n'exigent pas de programmes d’essai, car 'appareil utilise la mémoire de masse USB, ce qui permet d’accéder aux
fichiers photos comme s'ils étaient stockés sur un disque dur externe. Pour tout systéme d’exploitation Windows, si vous ne disposez
pas déja d’un logiciel d'édition de photos, vous pouvez installer le Roxio PhotoSuite® qui se trouve sur votre CD-ROM. Veillez &
lire entiérement les instructions d’utilisation, en notant les astuces ou les problémes potentiels s'appliquant  la configuration et au
systeme d’exploitation de votre ordinateur.

AVERTISSEMENT : Veillez a télécharger les images de votre appareil avant de
retirer les piles.

Transfert de photos et de vidéos sur votre ordinateur - Etape par étape

1. Veillez 4 installer d’abord un programme d’essai si Windows 98/98SE est votre systéme d’exploitation.
2. Reliez le cable fourni au port USB de I'appareil ImageView, puis directement au port USB principal de votre
ordinateur. N'utilisez pas les ports USB du panneau avant/clavier, ni des « moyeux » non alimentés.
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Transfert de photos et de vidéos sur votre ordinateur

3. Lécran LCD affiche « STO », et I'appareil ImageView sera reconnu comme un appareil standard « 8 mémoire de masse
USB ». Cela signifie que les fichiers de I'appareil photo peuvent étre facilement visualisés, modifiés ou copiés sur votre
disque dur comme s'ils étaient stockés sur un disque dur externe ou un CD-ROM.

4. (Cette érape est facultative avec Windows XP ; utilisez simplement les options de la fenétre flash pour visualiser, copier
ou modifier vos photos). Ouvrez « My Computer » (mon ordinateur) ou Windows Explorer. Lappareil photo apparait
comme un nouveau « Removable Disk » (disque amovible) avec la lettre de lecteur inutilisé qui lui est affectée. Cliquez
deux fois sur cette nouvelle icone « Disk », ouvrez le dossier DCIM qui se trouve a I'intérieur, puis le(s) dossier(s) se
trouvant a 'intérieur de ce dernier (« 100MEDIA », etc.). Vos photos/vidéos sont dans les fichiers & 'intérieur ; elles sont
dotées du préfixe « IMG_ », suivi d’'un numéro, celui que vous avez vu précédemment sur I'écran de I'appareil photo,
lorsque vous visualisez les photos. Cliquez une fois sur n'importe quel fichier pour faire apparaitre une petite image de
prévisualisation.

5. Cliquez sur « Edit>Select All » (modifier>sélectionner toutes) (ou cliquez sur une photo, control+click pour sélectionner
plusieurs photos), puis « Edit>Copy to Folder » (modifier>copier vers dossier) (dans les menus Windows).

Sélectionnez un dossier existant sur votre disque dur, par exemple « My Pictures » (mes photos), ou créez un nouveau
dossier (« Vacances & Hawai », etc.), puis cliquez sur « OK » pour transférer les copies des fichiers photos que vous
voulez.

6. Une fois les photos transférées sur le disque dur, vous pouvez débrancher I'appareil photo. Windows 2000 peut
produire & I'écran un avertissement indiquant que vous avez débranché un appareil USB sans arréter ou éjecter le « disque
» préalablement (vos fichiers photos ne seront pas endommagés). Dans ce cas, vérifiez la boite qui ajoute une icone dans
le plateau ou la barre de tiches de votre systéme. Ainsi, la prochaine fois que vous terminerez le transfert de photos, vous
pourrez cliquer d’abord sur cette icéne et sur « Stop the USB Mass Storage Device » (arréter 'appareil 8 mémoire de masse
USB) avant de débrancher I'appareil. (Sur les ordinateurs Mac, vous devez « éjecter » le disque qui est apparu sur votre
surface de bureau lors du branchement de 'appareil.)
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Transfert de photos et de vidéos sur votre ordinateur

7. Vous étes désormais prét & ouvrir les fichiers photos dans n'importe quel logiciel d’édition de photos. Il suffit d'utiliser File>Open
(fichier>ouvrir) et d’aller au dossier olt vous avez stocké les photos précédemment. Si vous utilisez PhotoSuite, sélectionnez
File>Open Photo, puis utilisez le menu déroulant « Look in » (regarder) en haut de la fenétre Open Window, sélectionnez « My
Computer », sélectionnez votre disque dur et cliquez deux fois sur n'importe quelle photo dans le dossier olt vous avez copié les
fichiers provenant de votre appareil photo. Il est également possible d’ouvrir et d'utiliser les photos directement depuis I TmageView
s'il est encore branché. Pour ce faire avec PhotoSuite, suivez d’abord les étapes 1 4 3, puis ouvrez PhotoSuite, sélectionnez
File>Open Photo (fichier> ouvrir photo) et utilisez le menu « Look in » (regarder) pour sélectionner « My Computer », puis
sélectionnez le « Disque amovible » et ouvrez les dossiers se trouvant & Iintérieur jusqu’a ce vous parveniez aux fichiers photos
JPEG. Si vous choisissez de travailler de cette fagon, 4 partir d’un appareil photo connecté, veillez 4 sauvegarder la photo (lorsque
vous avez fini I'édition) sur votre disque dur et non pas dans la mémoire ou la carte mémoire de votre appareil. Pour effectuer
cette démarche dans PhotoSuite, aprés avoir cliqué sur « Done » (fini), répondez 2 « Save Changes? » (voulez-vous sauvegarder les
changements ?) par Oui, mais ensuite, répondez & « Replace existing File? » (voulez-vous remplacer le fichier existant ?) par Non,
et utilisez la boite de dialogue « Save As » (enregistrer sous) pour sauvegarder la photo éditée dans un dossier sur votre disque dur
(«Save In > Local Disk [Enregistrer dans> disque local] »), et non sur le « disque amovible » (appareil photo).

8. Si vous étes novice en mati¢re d’édition de photos sur un ordinateur, consultez le menu « Help » (Aide) de votre logiciel
(PhotoSuite comporte une importante fonction intégrée d’Aide) pour y trouver des détails sur I'utilisation de ses fonctions.
Non seulement vous pouvez ajuster la brillance, le contraste, la netteté et la couleur de vos photos, mais vous pouvez aussi les
redimensionner 4 la mesure du papier si vous I'imprimez, ou sauvegarder une petite version 4 basse ou moyenne résolution pour
T'envoyer par courriel ou Iinsérer dans des documents. Lorsque vous étes prét & enregistrer votre fichier modifié, vous pouvez
utiliser la fonction « Save as » (enregistrer sous) et lui donner un nom plus descriptif que « IMG_ ». Cela permet de préserver le
fichier d’origine comme fichier de sauvegarde pour le rouvrir et le modifier & nouveau plus tard. Assurez-vous que vous avez réussi
le transfert de toutes les photos que vous souhaitiez sauvegarder avant d'utiliser « Delete All » (effacer toutes) sur votre appareil

photo dans le but de créer de la place pour de nouvelles photos.
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INST! SAGE DE VOS JUMELLES

TIONS CONCERNANT

Vos jumelles Bushnell constituent un instrument de précision congu pour vous assurer de
nombreuses années d’utilisation. Cette partie du livret vous permettra d’en obtenir une performance
optimale, car il vous explique comment ajuster vos jumelles en fonction de vos yeux, et comment
entretenir cet instrument. Lisez bien les instructions avant d'utiliser vos jumelles.

REGLAGES EN FONCTION DE VOS YEUX (Figure 1)

Comment régler la distance entre vos yeux

La distance entre les yeux, appelée « distance interpupillaire », varie d’une
personne 2 l'autre. Pour obtenir un alignement parfait entre la lentille et
P'eeil, suivez ces simples étapes. DISTANCE INTERPUPILLAIRE

1. Tenez vos jumelles en position de visée normale.

2. Tenez fermement chaque lunette. Rapprochez ou éloignez les lunettes 'une
de l'autre jusqu'a ce que vous perceviez un champ circulaire. Remettez
toujours vos jumelles dans cette position avant de les utiliser.

Comment régler en fonction de votre vision

Comme la vision varie d’'une personne & une autre, la plupart des jumelles Bushnell comportent un réglage
dioptriquequi vous permet de régler avec précision les jumelles en fonction de votre vision. Suivez les
instructions de mise au point suivantes correspondant a votre type de jumelles.
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MISE AU POINT

1. Réglez la distance interpupillaire. (Figure 1)

2. Mettez le “réglage dioptrique”(Figure 2) sur zéro et observez un objet éloigné.
3. Gardez les deux yeux ouverts en permanence.

4. A Paide d’un couvercle d’objectif ou de votre main, couvrez l'objectif (avant) du ‘gww*%_—,-

coté des jumelles qui comporte le « réglage dioptrique », généralement le coté

- .
REGLAGE DIOPTRIQUE

droit. (Le coté gauche sur les modéles & zoom.)

5. A Taide de la molette centrale, effectuez la mise au point pour un objet éloigné
comportant des détails précis (par ex., un mur en briques, des branches d’arbre, etc.) jusqua ce qu'il apparaisse
aussi net que possible.

6. Découvrez la lentille d’objectif coté dioptre, couvrez I'autre lentille d’objectif, puis observez le méme objet.

7. A Paide de la bague de correction dioptrique, effectuez la mise au point pour I'objet observé. Il convient de
prendre des précautions, car retourner ou forcer 'oculaire de correction dioptrique peut endommager celui-ci
ou le détacher du chassis.

8. Vos jumelles doivent étre adaptées a vos yeux. La mise au point de loin ou de prés peut désormais étre réalisée en
tournant simplement la molette de mise au point centrale. Prenez note du réglage dioptrique en fonction de vos

yeux pour référence ultérieure.

CEILLETONS (Figure 3)

Vos lunettes Bushnell sont dotées d’ceilletons en caoutchouc rabattables,
congus pour votre confort et pour bloquer la lumiére parasite.

Si vous portez des lunettes optiques ou des lunettes de soleil, rabattez les
illetons. Cela permet de rapprocher vos yeux de la lentille des jumelles,

méliorant ainsi le champ de vision.
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INSTRUCTIONS POUR L'ENTRETIEN DE VOS JUMELLES

Vos jumelles Bushnell vous assureront des années de service sans problémes si vous en prenez soin
comme de tout autre instrument d’optique de qualité. CImageView n’est pas étanche et ne doit pas
étre exposé & 'humidité. Les dommages causés par I'eau ne sont pas couverts par la garantie.

1. Si vos jumelles sont munies d’ceilletons flexibles rabattables, rangez-les avec les ceilletons relevés. Cette
position permet d’éviter les contraintes et I'usure des ceilletons s’ils sont en position abaissée.

2. Evitez de heurter et de laisser tomber les jumelles.

3. Rangez-les dans un endroit frais et sec.

4. AVERTISSEMENT : Lobservation directe du soleil avec les jumelles peut causer des Iésions oculaires
permanentes.

5. N’exposez jamais vos jumelles ImageView & un excés de liquides ou de fluides, car elles ne sont ni
étanches ni antibuée.

6. Retirez les piles de votre ImageView si vous prévoyez de ne pas l'utiliser pendant une longue période.
(Veillez & télécharger les images de votre appareil photo avant de retirer les piles.)

NETTOYAGE

1. Soufflez doucement pour chasser toute poussi¢re ou débris des lentilles (ou utilisez une brosse
douce).

2. Pour chasser les impuretés ou les traces de doigts, frottez en un mouvement circulaire avec un chiffon
doux en coton. Lusage d’un chiffon rugueux ou le frottement superflu peut rayer la lentille et causer
des dommages permanents. Un chiffon de nettoyage en « microfibres » (en vente chez la plupart des
marchands-photographes) est idéal pour le nettoyage de routine des éléments optiques.

3. Pour un nettoyage plus approfondi, du papier pour lentilles photographiques et du nettoyant
photographique ou de I'alcool isopropylique peuvent étre utilisés.Appliquez toujours le nettoyant
sur le chiffon — jamais directement sur la lentille.
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[GARANTIE LIMITEE DE DEUX ANS

Votre produit Bushnell® est garanti exempt de défauts de matériaux et de fabrication
pendant deux ans aprés la date d'achat. Au cas ot un défaut apparaitrait sous cette
garantie, nous nous réservons l'option de réparer ou de remplacer le produit, 2 condition
de nous le fenvoyer en port paye. La prescn(e garantie ne couvre pas les dommages
causés par une un une ou un
entretien incorrect ou fourni par quelqu un d'autre qu'un centre de réparation agréé
par Bushnell

Remarque relative 4 la FCC (Commission fédérale deq
télécommunications)

Cematériel aété testé ets'est révélé étre conforme aux limites
dun dispositif numérique de classe B, conformément a I
section 15 de la réglementation FCC. Ces limites ont ét
établies pour assurer une protection raisonnable contre
les parasites nuisibles dans les immeubles résidentiels;
Ce matériel produit, utilise et peut émettre de I'énergi

Tout retour effectué dans le cadre de la présente garantie doit étre ¢ des
articles indiqués ci-dessous :

1) un chéque ou mandat d'une somme de 10,00 $ US pour couvir les frais
d'envoi et de manutention

2) le nom et I'adresse pour le retour du produit

3) une description du défaut constaté

4) la preuve de la date d'achat

5) Le produit doit étre emballé soigneusement, dans un carton d'expédition
solide, pour éviter qu'il ne soit endommagé durant le transport ; envoyez-le
en port payé, 4 l'adresse indiquée ci-dessous :

Aux Erats-Unis, envoyez a: Au CANADA, envoyez a:
Bushnell Outdoor Products Bushnell Performance Optics
Attn.: Repairs Attn.: Repairs

8500 Marshall Drive 25A East Pearce Street, Unit 1
Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

Pour les produits achetés en dehors des Etats-Unis et du Canada, veuillez contacter votre
distributeur local pour tous renseignements concernant la garantie. En Europe, vous
pouvez aussi contacter Bushnell au : BUSHNELL Performance Optics Gmbh
European Service Centre
MORSESTRASSE 4
D- 50769 Cologne

Allemagne
Tél: +49 (0) 221 709 939 3
Fax: +49 (0) 221 709 939 8

La présente garantie vous donne des droits légaux spécifiques.

Vous pouvez avoir d'autres droits qui varient selon les pays.
©2006 Bushnell Outdoor Products

sen éq §'il nest pas installé e
it et eviee Ibs instructions, il nsque it
provoquer des parasites nuisibles aux
radio. Toutefois, il n'est pas garanti que des parasites n
se produiront pas dans une installation particuliére. Si c
matériel causait des parasites nuisibles  la réception radi
ou télévision, qui peuvent étre déterminés en mettant
matériel hors tension puis sous tension, l'utilisateur peu
essayer de remédier au probléme en appliquant I'une o
plusieurs des mesures suivantes :

+ Réorienter ou déplacer I'antenne de réception.

- Augmenter la distance séparant le matériel du récepteur,
- Connecter le matériel 4 une prise de courant ou 2 un
circuit différent(e) de celui (celle) auquel (3 laquelle) I
récepteur est relié.

- Consulter le concessionnaire ou un technicien radio/TV|
expérimenté.

Le cible d’interface blindé doit étre utilisé avec le matériel
afin d'étre conforme aux limites d’un dispositif numérique.
conformément  la sous-section B de la section 15 de I
réglementation FCC

Les spécifications et conceptions sont  sujettes
modification sans préavis ni obligation de la part dy

fabricant.
S
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ADVERTENCIA

Asegrese de descargar las fotos de la cdmara ANTES de quitar o cambiar las
pilas, a menos que haya estado usando una tarjeta SD en vez de la memoria
interna para almacenar las fotos. Recomendamos que descargue todos los
archivos de fotos actuales para guardarlos antes de guardar la ImageView si
no estd usando una tarjeta SD en la cdmara, en caso de que las pilas se agoten
durante un almacenamiento prolongado.

ADVERTENCIA

NO mire directamente al sol por sus binoculares.
Al hacer esto se puede producir dafios permanentes en los ojos.

NOTA: Para reajustar la cdmara si tiene problemas o si la pantalla no responde,
saque las pilas al menos un minuto y vuelva a instalarlas. Esto puede resultar en
la pérdida de todas las fotos/videos guardados en la memoria interna.
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EsPANOL

iEnhorabuena por la compra de los binoculares ImageView® de
Bushnell! Los binoculares ImageView de Bushnell adoptan la
tecnologia fotografica digital y la combinan con unos binoculares
compactos de alta calidad. Esto le permite observar acontecimientos
deportivos, fauna salvaje, vistas pintorescas o cualquier cosa para la que
normalmente usarfa unos binoculares, y después guardar la imagen en
una cdmara digital adjunta integrada. A continuacién podra descargar
estas imdgenes en el ordenador y enviarlas por correo a sus amigos
y familia, imprimir la foto usando el software incluido o guardarlas
en un dlbum de fotos para el futuro. Antes de usar el producto, lea
las instrucciones contenidas en este manual y témese el tiempo para

familiarizarse con las distintas piezas y caracteristicas del producto.
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Guia de piezas de cimara y Binocular

I \
Enfoque Botén Botén
de los Snap  Lente Mode
binoculares de la

cdmara
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Configuracién y operacién bésica
1. La cdmara estd alimentada por dos pilas AAA alcalinas, de litio o NiMh (no incluidas). Introduzca las pilas

en el compartimiento, con los resortes en contacto con el extremo negativo (plano) de cada pila. La presencia
de un medidor de corriente en el centro izquierdo de la pantalla indica el estado de las pilas.

2. Introduzca una tarjeta SD ("boca abajo" con los contactos de metal apuntando hacia arriba) en la ranura
si se desea una mayor capacidad de almacenamiento. Puede usar tarjetas SD (no tarjetas MMC) de hasta
1 GB de capacidad. La cdmara tiene 8 MB de memoria interna que puede contener més de 100 fotos, de
modo que no es necesaria una tarjeta. No obstante, el contenido de la memoria interna se perderd si se sacan
las pilas o se agotan, a diferencia de las fotos almacenadas en una tarjeta de memoria SD. Se dispone de una
tarjeta SD estdndar de 256 MB en la mayorfa de las tiendas de componentes electrénicos o de ordenadores
y es una buena opcién para su ImageView.

3. Pulse sin soltar el botén MODE hasta que se encienda la cdmara. La cdmara se apagard automdticamente
después de aproximadamente un minuto si no se pulsa ningtin botén. Nota: cuando la cdmara esté conectada
a un ordenador por el cable USB incluido, la cdmara se encenderd automdticamente, y absorberd corriente
del ordenador sin drenar las pilas.

4. Mantenga fija la ImageView y pulse SNAP para tomar una foto (o empezar/dejar de filmar un video,
cuando la cdmara esté en la modalidad de video). El foco de la cdmara estd prefijado para tomar fotos nitidas
desde aproximadamente 10,5 m (35 pies) al infinito.

5. Cuando se use un tripode, puede evitar los efectos de vibracién de la cdmara conectando el disparador del
obturador remoto suministrado en el jack junto a la ranura de la tarjeta SD, y usando el botén del control
remoto en vez de pulsar SNAP para tomar fotos.
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USO DE LAS MODALIDADES DE OPERACION/AJUSTE DE FECHA Y HORA

La ImageView imprimird la fecha y la hora en la esquina inferior derecha de las fotos. Para fijar
la fecha y la hora actuales, después de encender la cdmara, pulse sin soltar los botones MODE y
SNAP al mismo tiempo, hasta que la pantalla empiece a destellar. La pantalla muestra ahora los
dos dltimos digitos del afio. Pulse el boton MODE para mover el cursor al segundo digito si es
necesario. Pulse el botén SNAP para hacer avanzar el digito al afio actual ("07" para 2007, etc).
Después, pulse MODE para ir al ntimero siguiente, que es el mes. Use nuevamente SNAP para
cambiar esto al mes actual. A continuacién de la pantalla del mes estd: fecha, hora (formato
de 24 horas), minutos y segundos-continde fijando éstos siguiendo el mismo proceso con los
botones MODE y después SNAP. Cuando haya completado todos los ajustes de fecha/hora, la
pantalla dejard de destellar y volverd a normal. Observe que tendrd que reajustar la fecha/hora
después de reemplazar las pilas. Su ImageView ya estd fijada en alta resolucién y alta calidad
nada mds sacarla de la caja, y no es necesario usar los ajustes MODE ni hacer ningtin cambio
para obtener buenos resultados pulsando simplemente el botén SNAP para tomar las fotos.
No obstante, ya que como también podria filmar un clip de video, borrar una o mds fotos,
o explorar otras opciones, recomendamos que revise las opciones de modalidades disponibles
indicadas en las pdginas siguientes. Pulsando brevemente el botén MODE podrd recorrer estas
modalidades de operacién en el orden indicado, y podrd ver el icono para cada modalidad junto
con su ajuste actual en la pantalla. Use el botén SNAP para seleccionar el ajuste deseado para
cualquier modalidad. Si no efectia ningtin cambio, y no se pulsa el botén SNAP o MODE en
un plazo de 5 segundos, la cdmara volverd a la operacién y visualizacién normales.
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Uso de las modalidades de operacién
(los ajustes predeterminados se indican en negrita)

Modalidad Icono Ajustes Descripcién

Video Cdmara de OFF (apagada), Seleccione una resoluciéon de video "Hi"
video High (alta) (recomendada) o "Lo" en vez de "OFF" para
(640x480 pixels poner la cdmara en la modalidad de video. Espere
por cuadro, 15 unos pocos segundos para que la cdmara vuelva
pie/s), Low (baja) automdticamente a la pantalla normal, y después
(320x240 pixels) empiece a filmar pulsando SNAP. El contador
mostrard el tiempo transcurrido, hasta 53 (alta) o
132 (baja) segundos como mdximo para cada clip
de video. Pulse SNAP otra vez para dejar de filmar.
El contador avanzard una unidad, indicando que el
archivo de video se ha guardado. Vuelva al ajuste de
modalidad de video y seleccione OFF para reajustar

la cdmara a la modalidad de fotos fijas.

Calidad Hqolq High (alta), Low Seleccione calidad "Hi" (recomendada) o "Lo" para
(baja) escoger la cantidad de compresion de archivos, lo

que afecta el tamano del archivo de fotos. "Lo" per-
mite almacenar mds fotos en la memoria, pero de
menor calidad.

Resolucién HioLo High (alta) Seleccione resolucién "Hi" (recomendada) o "Lo",
(640x480 dependiendo de si prefiere mejores fotos (Hi) o de-
pixels), Low (baja) | sea almacenar un mayor nimero de fotos (Lo).
(320x240 pixels)
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Uso de las modalidades de operacién

Modalidad

Icono

Ajustes

Descripcién

Frecuencia de
linea

60 6 50

60 Hz, 50 Hz

Fije para hacer coincidir la frecuencia (ciclos) de
CA de su pais. Esto asegura que las fotos fijas y los
videos filmados con iluminacién fluorescente parez-
can normales.

Continua

CT

OFF, 3, 5

Seleccione 3 6 5 cuadros para tomar una serie rdpida
de fotos en vez de un solo cuadro cuando se pulse
SNAP (en la modalidad normal de fotos fijas). Para
cancelar, entre en esta modalidad nuevamente y se-
leccione OFE.

Acceso de
memoria

MEM

Sto (almace-
namiento masivo
USB), PC (cdmara
USB)

Seleccione "Sto" para tener acceso a la memoria
interna o de la tarjeta cuando la cdmara esté
conectada a un ordenador por medio de una cable
USB. "PC" permite usar una cdmara USB/PC en
vivo (observe que los 8 aumentos y la carencia de
capacidad de enfoque cercano limita su utilidad en
la mayorfa de los tamanos de habitaciones)

Borrar ultimo

LSt+Papelera

Ninguno-pulse
SNAP para borrar
la tltima foto o
video

Seleccione esta modalidad y pulse SNAP para bor-
rar sélo la tltima foto o video tomados. El contador
disminuird en una unidad.
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Uso de las modalidades de operacién

Modalidad Icono Ajustes Descripcién
Borrar todo ALL Ninguno-pulse Seleccione esta modalidad y pulse SNAP para bor-
+Papelera SNAP para borrar | rar todo el contenido de la memoria (el contador se
todos los archivos reajusta a cero). Use esto después de descargar sus
de fotos y videos archivos para borrar la memoria a fin de poder to-
mar fotos nuevas. Si se selecciona "Delete All" por
accidente, espere simplemente unos segundos y la
cdmara volverd a la operacién normal.
Formato FOr Ninguno-pulse Si estd usando una tarjeta SD nueva, o una usada
+Papelera SNAP para for- con anterioridad en otros dispositivos, recomenda-
matear la tarjeta o | mos que seleccione Format y pulse SNAP antes
la memoria interna | de empezar a tomar fotos, de modo que la tarjeta
esté configurada con el sistema de archivo de datos
correcto para esta cimara. Observe que al format-
ear una tarjeta se borrard su contenido-asegiirese
primero de haber hecho una copia de los archivos
anteriores
Auto- Reloj OFF (desactivado) | La foto se toma con una demora de 10 segundos cuando
temporizador 0 On (activado) se pulsa SNAP (en la modalidad normal de fotos fijas).

Esto puede usarse para evitar por accidente que se sacuda
la cdmara cuando se pulse el botén SNAP. Si se dispone de
cable de obturador remoto, éste se debe usar en vez del au-
totemporizador cuando se monte la cdmara en el tripode. El
temporizador se cancela automdticamente después del uso.

43




USO DE LA IMAGEVIEW CON UN ORDENADOR:

1. La cdmara ser4 reconocida como un dispositivo de almacenamiento masivo USB (si est4 fijada en "STO"
y no en "PC"), lo que significa que no se requieren controladores especiales para todos los sistemas
operativos posteriores a Windows 98 (Me, 2000, XP). Mac OS 9 y OSX también son compatibles.
Si tiene una PC con Windows 98, debe instalar el controlador encontrado en el CD-ROM incluido
ANTES DE CONECTAR LA CAMARA A SU PC.

2. Si tiene un ordenador OS, segun se indica arriba, que cumpla con el almacenamiento masivo USB,
aparecerd un nuevo icono de disco en Windows Explorer (en “Mi PC”) como nuevo “Disco extraible”
después de enchufar el cable USB de la Imageview. Los usuarios de Mac verdn aparecer el nuevo
dispositivo en su despacho. Al hacer clic en el icono del nuevo disco se mostrard el contenido, una
carpeta llamada “DCIM”. La carpeta de imdgenes del interior contiene sus fotos, almacenadas como
JPEG (formato de archivos .jpg). Pueden abrirse, modificarse, cambiarse de nombre y guardarse usando
cualquier software de fotos o gréficos que acepte archivos .jpg. Si no dispone de software que abra
archivos .jpg, debe instalar MGI Photosuite (Windows solamente) del CD-ROM incluido. Vea las
instrucciones en “Instalacién del software”.

3. Después de haber copiado o abierto y guardado los archivos de fotos en el disco duro de su ordenador,
podrd desconectar la cdmara Imageview (no desconecte NUNCA la cimara mientras se estén
transfiriendo archivos a su ordenador). Antes de desconectar, debe “expulsar” o detener el disco extraible
que representa la cdmara para evitar un mensaje de error (no es necesario con Windows XP).

4. Vea las pdginas siguientes para obtener instrucciones completas paso a paso para descargar las fotos.
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Requisitos del sistema (minimos)

OS: Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ equivalente o mds rédpida (Pentium® III 500 MHz para PhotoSu-

ite5™)

Memoria: 32MB minimo (64MB recomendada para PhotoSuite)

Tarjeta de video SVGA con 2MB de VRAM, pantalla de 800x600, 16 bit High color

Espacio de disco duro de 200 MB (si va a instalar PhotoSuite)

Puerto USB interno

Instalacion del software

Si estd usando Windows 98, debe instalar los controladores antes de conectar la cdmara a su PC. Introduzca el CD-
ROM en la unidad de CD del ordenador; se ejecutard automdticamente y se visualizard la pantalla de instalacién.
Seleccione “Instale el controlador” y siga después las instrucciones. Después de la instalacién, vuelva a iniciar su com-
putadora. Windows 2000, ME y XP no requieren controladores, ya que la cdmara usa la norma de almacenamiento
masivo USB, permitiendo tener acceso a los archivos de fotos como si estuvieran almacenados en una unidad de disco
duro externa. Para cualquier Windows OS, si no estd usando ya el software de modificacién de fotos preferido, puede
instalar Roxio PhotoSuite® del CD-ROM. Asegtirese de leer completamente las “Notas de la versién”, observando
cualquier recomendacion o asunto potencial pertenecientes a su configuracién PCy OS.

ADVERTENCIA: Asegiirese descargar cualquier foto de la cimara antes de sacar las pilas de
la misma.

Transferencia de las fotos y videos a su PC - Paso a paso

1. Asegtirese de que el controlador se haya instalado primero si estd en Windows 98/98SE.
2. Conecte el cable suministrado al puerto USB de ImageView y después directamente al puerto principal de USB
en su ordenador-no use puertos USB del tablero delantero/teclado o “concentradores” sin corriente.
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Transferencia de las fotos y videos a su PC

3. La pantalla LCD indicard “STO”, y la ImageView serd reconocida como un dispositivo estdndar de
“Almacenamiento masivo USB”. Esto significa que los archivos de la cdmara pueden verse, modificarse
o copiarse facilmente en su disco duro, justo como si se almacenaran en una unidad de disco externa
o en CD-ROM.

4. (Este paso no se requiere con Windows XP, use simplemente las opciones de la ventana emergente
para ver, copiar o modificar sus fotos). Abra Mi PC o Windows Explorer. La cdmara se verd como un
nuevo “Disco extraible” con una letra de unidad sin usar asignada. Haga doble clic en este nuevo icono
de “Disco”, abra la carpeta “DCIM” de dentro, y después las carpetas de dentro (“100MEDIA”, etc).
Sus fotos/videos son los archivos de dentro-tienen el prefijo “IMG__" seguido de un niimero, igual que
se ve antes en la pantalla de la cdmara al revisar fotos. Al hacer un solo clic en cualquier archivo se debe
mostrar una pequefa imagen preliminar.

5. Haga clic en “Editar>Seleccionar todo” (o haga clic en una foto, control+clic para seleccionar miltiples
fotos) y después en “Editar>Copiar a la carpeta” (en los ments de Windows). Seleccione una carpeta
existente en su unidad de disco duro, como “Mis imdgenes”, o cree una nueva carpeta (“Vacaciones en
Hawai”, etc), y después haga clic en “OK” para transferir copias de los archivos de fotos deseados.

6. Después de transferir las fotos a su unidad de disco duro, puede desconectar la cdmara. Windows
2000

puede producir una advertencia de pantalla de que se ha desconectado un dispositivo USB sin detenerse
o expulsar el “disco” primero (sus archivos de fotos no resultardn perjudicados). Si es asi, marque la casilla
que afiade un icono a su bandeja del sistema o barra de tareas. Después, la siguiente vez que termine
de transferir datos, puede hacer clic primero en ese icono, y “Parar el dispositivo de almacenamiento
masivo USB” antes de desconectar la cdmara. (En ordenadores Mac, se debe “expulsar” el “disco” que ha
aparecido en su despacho cuando se haya desconectado la cdmara).
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Transferencia de las fotos y videos a su PC

7. Ahora estd listo para abrir los archivos de fotos en cualquier software de modificacién de fotos. Use simplemente
Archivo>Abrir y vaya a la carpeta donde haya guardado las fotos antes. Si estd usando PhotoSuite, seleccione
Archivo>Abrir foto, y después use el ment de despliegue “Buscar en” en la parte de arriba de la ventana Abrir,
seleccione “Mi PC”, seleccione la unidad de disco duro y haga doble clic en cualquier foto de la carpeta donde se
copiaron archivos de la cdmara. También es posible abrir y trabajar con sus fotos directamente de la ImageView
mientras siga conectada. Para hacer esto con PhotoSuite, siga primero los pasos 1-3 y después abra PhotoSuite,
seleccione Archivo>Abrir foto y use el ment “Buscar en” para seleccionar Mi PC. A continuacién, seleccione el
“Disco extraible” y abra las carpetas de dentro hasta que obtenga los archivos de fotos JPEG. Si desea trabajar de esta
manera, desde una cdmara conectada, asegiirese de guardar la foto (cuando termine la modificacién) en su unidad
de disco duro, y no en la memoria o tarjeta de la cdmara. Para hacer esto en PhotoSuite, después de hacer clic en
“Hecho”, conteste “;Guardar cambios?” con “S{”, pero después conteste “;Reemplazar archivo existente”? con “No” y
use la casilla de didlogo “Guardar como” para guardar la foto modificada en una carpeta en su unidad de disco duro
(“Guardar en>Disco local”), no en el “Disco extraible” (cimara).

8. Si va a modificar una foto por primera vez en un ordenador, consulte el ment de Ayuda del software (PhotoSuite
tiene una Ayuda integrada amplia) para obtener recomendaciones sobre c6mo usar estas caracteristicas. Junto con el
ajuste del brillo, contraste, nitidez y color de sus fotos, puede cambiar el tamaio de la foto para que se adapte al papel si
lo estd imprimiendo, o guardar una versién de resolucién menor, baja o intermedia para enviar por correo electrénico o
insertar en documentos. Cuando esté listo para guardar su archivo modificado, puede usar “Guardar como” y darle un
nombre mds descriptivo que “IMG___". Al hacer esto se conserva el archivo original como una copia de reserva para
volver a abrir y volver a modificar més adelante. Asegfirese de haber transferido con éxito todas las fotos que deseaba
guardar antes de usar “Borrar todo” en su cdmara para dejar sitio para nuevas imdgenes.
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INSTRUCCIONES PARA LOS BINOCULARES

Sus binoculares Bushnell son es un instrumento de precisién disefiado para proporcionar muchos
afios de vision agradable. Esta parte del librito le ayudard a lograr el rendimiento éptimo explicando
cémo ajustar los binoculares a los ojos, y cémo cuidar este instrumento. Lea las instrucciones con
cuidado antes de usar los binoculares.

AJUSTES DE LOS 0JOS (Figure 1)

Cémo ajustar la distancia entre los ojos

La distancia entre los ojos, llamada “distancia entre pupilas”, varfa de una a
otra persona. Para lograr el alineamiento perfecto de la lens del ojo, siga
estos pasos sencillos.

1. Sujete los binoculares en su posicién de visién normal.

2. Agarre cada cilindro con firmeza. Acerque o aleje los cilindros hasta que vea
un solo campo circular. Reajuste siempre los binoculares a esta posicion

Distancia entre pupilas

antes de usarlos.

Cbmo ajustar segtin la vista de las personas

Como la vista varfa de una persona a otra, la mayorfa de los binoculares Bushnell tiene una funcién de
ajuste didptrico que permite ajustar los binoculares con precisién a su vista. Siga las instrucciones
de enfoque de abajo para su tipo de binoculares.
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ENFOQUE

1. Ajuste la distancia entre pupilas. (Figura 1)

2. Fije el “ajuste di6ptrico” (Figura 2) en cero y mire a un objeto distante.

3. Mantenga los dos ojos abiertos en todo momento.

4. Usa‘ndo una tapa de l.eme 0 una mar?o, tape il}objeti\}f([) (d'ela’l}tero) del ‘gwe,-
mismo lado de los binoculares que tienen Ael ajuste diéptrico”. Se trata AJUSTE DIOPTRICO
normalmente del lado derecho. (El lado izquierdo en los modelos de

| S——

zoom).

5. Usando la rueda de enfoque central, enfoque un objeto distante con un detalle fino (por ejemplo, un
muro de ladrillo, ramas de drbol, etc.) hasta que aparezca lo més nitido posible.

6. Destape el objetivo en el lado didptrico, tape el otro objetivo y después mire al mismo objeto.

7. Usando el anillo de “ajuste diptrico”, enfoque el mismo objeto que se estd mirando. Se debe tener
cuidado, ya que se puede danar el ocular didptrico al girarlo excesivamente o forzarlo o se puede
desprender el ocular del chasis.

8. Sus binoculares deben ajustarse a sus ojos. El enfoque a cualquier distancia lejana o cercana puede
lograrse ahora simplemente girando la rueda central de enfoque. Haga una nota del ajuste didptrico
para sus ojos como futura referencia.

OJERAS (Figura 3) ig 3 S
Sus binoculares Bushnell disponen de ojeras de goma que se pueden
bajar disefiadas para su confort y excluir luz extrana. Si lleva gafas de

I ), I I
[y

sol/normales, baje las ojeras. Esto acercard sus ojos a las lentes de los [——===70IT
binoculares mejorando asi el campo de visién. ROLL-DOWN EYECUPS
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INSTRUCCIONES PARA EL CUIDADO DE BINOCULARES

Sus binoculares Bushnell le proporcionarén muchos afios de servicio sin problemas si reciben el
cuidado normal que le darfa a cualquier instrumento éptico de calidad. La Imageview no es a prueba
de agua, y no debe exponerse a ninguna fuente de humedad. Los dafos ocasionados por el agua no
estdn cubiertos por la garantia.

1. Sisus biboculares disponen de ojeras flexibles que se bajan, gudrdelos con las ojeras hacia arriba. Esto
evita una tension excesiva y el desgaste de las ojeras en la posicién bajada.

2. No la golpee ni la deje caer.

3. Guarde en un lugar fresco y seco.

4. ADVERTENCIA: La mirada directa al sol con los binoculares puede causarle dafios permanentes
en elos ojos.

5. No exponga nunca sus binoculares ImageView a ningtin exceso de liquido o fluido, ya que no es a
prueba de agua/neblina.

6. Saque las pilas de su ImageView si no va a usarlos durante un perfodo largo. (Asegtrese de descargar
las fotos de su cdmara antes de sacar las pilas).

LIMPIEZA

1. Sople el polvo o residuos de la lente (o use un cepillo suave para lentes).

2. Para eliminar la suciedad o las huellas dactilares, limpie con un trapo de algodén suave frotando y
siguiendo un movimiento circular. El uso de un trapo dspero o el rozamiento innecesario puede
rayar la superficie de la lente y con el tiempo causar dafios permanentes. El uso de un trapo de
limpieza de “microfibras” (disponible en la mayorfa de las tiendas de fotos) es ideal para la limpieza
de rutina de su sistema 6ptico.

3. Para lograr una limpieza mds completa, se puede usar papel fotogrifico para lentes y fluido de

limpieza para lentes de tipo fotogréfico o alcohol isopropilico. Aplique siempre el fluido en el pano
de limpieza — nunca directamente en la lente.
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IGARANTIA LIMITADA de DOS afios

Su producto Bushnell estd garantizado contra defectos de materiales y fabricacion du-

ante dos afos después de la fecha de compra. En caso de defectos bajo esta garantia,

10s0tros, a nuestra opcion, repararemos o sustituiremos el producto siempre que lo

Hevuelva con portes pagados. Esta garantia no cubre defectos causados por el uso inde-

bido, ni por un manejo, instalacién o mantenimiento realizados por alguien que no sea

un departamento de servicio autorizado de Bushnell.

Cualquier envio que se haga bajo esta garantia deberd ir acompanado por lo siguiente:

1) Un cheque/giro postal por la cantidad de 10 délares para cubrir los gastos postales y de manejo

2) Nombre y direccién donde quiere que se le envie el producto

3) Una explicacion del defecto

4) Una prueba de la fecha de compra

5) El producto debe empaquetarse bien en una caja resistente para evitar que se dafie durante el
transporte, con los portes prepagados a la direcciUn que se muestra a continuacién:

En EE.UU. enviar a: En CANADA enviar a:

Bushnell Outdoor Products

Attn.: Repairs

25A East Pearce Street, Unit 1

Richmond Hill, Ontario L4B 2M9

Bushnell Outdoor Products
Attn.: Repairs

500 Marshall Drive
Lenexa, Kansas 66214

En el caso de productos comprados fuera de Estados Unidos o Canadd, pongase en con-
acto con su distribuidor local para que le den la informacién pertinente sobre la garantia.
En Europa también puede ponerse en contacto con Bushnell en:

BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 K+LN

ALEMANIA

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Esta garantia le ofrece derechos legales especificos.
Puede que tenga otros derechos que varian de un pais a otro.
©2006 Bushnell Outdoor Products

Nota deJa FCC:

Este equipo ha sido sometido a pruebas y cumple con

los limites establecidos para un aparato digital de Clase

B, de acuerdo con la Parte 15 del Reglamento de la

FCC. Estos limites estdn disefiados para proporcionar|

proteccion razonable contra interferencias perjudiciales

en una instalacién residencial. Este equipo genera,

emplea y puede irradiar energia de radiofrecuencial

¥, si no se instalada y utiliza de acuerdo con las|

instrucciones, puede causar interferencia perjudicial al

Tas radi icaci Sin embargo, no i

que no ocurrirdn interferencias en una instalacion|

en particular. Si este equipo causa interferencias

perjudiciales a la recepcion radial o televisiva, situacion|

que puede determinarse apagando y encendiendo el

equipo, se sugiere al usuario que trate de corregir tall

interferencia mediante uno o mds de las siguientes|

medidas:

- Reorientar o relocalizar la antena receptora.

- Incrementar la separacion entre el equipo y ell
receptor.

- Conectar el equipo a un tomacorriente en un circuitol
diferente al que estd conectado el receptor.

- Consultar con el concesionario o un técnico
experimentado en radio/television solicitandole|
asistencia.

Con este equipo se debe usar un cable de interfaz|
blindado para cumplir con los limites para un aparato
digital de acuerdo con la Subparte B de la Parte 15 dell
Reglamento de la FCC.

Las especificaciones y disefios estdn sujetos a cambios
sin ningin aviso u obligacién por parte del fabricante.

€
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WARNHINWEIS

Sorgen Sie dafiir, dass VOR dem Entfernen oder Wechseln der Batterien alle Bilder
von Threr Kamera herunter geladen wurden, aufler Sie haben fiir das Speichern der
Fotos eine SD Karte anstelle des internen Speichers verwendet. Wir empfehlen das
Herunterladen aller aktuellen Fotodateien zum Speichern vor dem Aufbewahren der
ImageView Kamera, falls Sie keine SD Karte in der Kamera verwenden, fiir den Fall,
dass die Batterien wihrend einer lingeren Aufbewahrungszeit leer werden.

WARNHINWEIS

NIE direkt mit dem Fernglas in die Sonne sehen.
Der direkte Blick in die Sonne kann zu einer dauerhaften Schidigung der Augen
fithren

HINWEIS: Zur Durchfiihrung eines Resets der Kamera, oder falls das Display nicht
mehr reagiert, entfernen Sie mindestens eine Minute lang die Batterien, dann setzen
Sie diese wieder ein.Dies kann zum Verlust aller im internen Speicher enthaltenen

Fotos/Videoaufnahmen fiibren.
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DEUTSCH
Herzlichen Gliickwunsch zum Kauf des Bushnell ImageView®

Fernglases! Das Bushnell ImageView Fernglas nutzt die Technologie
digitaler Fotografie und verbindet sie mit einem qualitativ hochwertigen,
kompakten Fernglas. Somit kénnen Sie Sportereignisse, Tieraufnahmen
und Landschaftsaufnahmen  betrachten oder das Fernglas fiir alle
iiblichen Verwendungszwecke einsetzen und danach das Bild in der
eingebauten, angeschlossenen Digitalkamera speichern. Danach kénnen
Sie diese Bilder auf Ihren Computer herunter laden und per E-Mail an
Thre Freunde und an Ihre Familie verschicken, das Bild mit Hilfe der
mitgelieferten Software ausdrucken oder die Bilder in einem Fotoalbum
zur spiteren Verwendung abspeichern. Bevor Sie Ihr neues Gerit
benutzen, lesen Sie bitte die Anweisungen in diesem Handbuch und
nehmen Sie sich Zeit, um sich mit den verschiedenen Komponenten und

den technischen Produkteigenschaften vertraut zu machen.
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Kamera und Fernglas
Teile-Handbuch

Kartenschlitz  USB
Port

Buchse fiir
Fernbedienung

Stativbuchse

Batteriefach

(Schieber offen in

Modus
Pfeilrichtung)

KaLera Taste Nr

Linse

Bildscll'airfe Taste
Fernglas ,Knipsen®
Nr.
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Ersteinrichtung und Grundbetrieb

1. Die Kamera wird durch zwei AAA Alkali-, Lithium, oder NiMh Batterien (nicht im Lieferumfang
enthalten) mit Strom gespeist. Legen Sie die Batterien in das Batteriefach ein, die Federn sind dabei in
Kontakt mit dem negativen (flachen) Ende jeder Batterie. Ein Strommessgerit im linken mittleren
Displaybereich zeigt den Zustand der Batterien an.

2. Legen Sie eine SD Karte ("mit der Oberseite nach unten® ein, wobei die Metallkontakte nach oben
gerichtet sind) in den Schlitz ein, falls cin groflerer Speicherplatz gewiinscht wird. Sie kénnen SD Karten
(keine MMC Karten) mit einer Speicherkapazitit von bis zu 1 GB verwenden. Die Kamera verfiigt iiber
cinen internen Speicher mit einer Speicherkapazitit von 8MB, der iiber 100 Fotos aufnehmen kann, folglich
ist keine Karte erforderlich. Der Inhalt des internen Speichers geht jedoch verloren, wenn die Batterien
entfernt werden oder verschiedenartige Fotos auf einer SD Speicherkarte gespeichert werden. Eine 256 MB
Standard Speed SD Karte ist in den meisten Elektro-Verbrauchermirkten oder Computerliden erhiltdich
und ist eine gute Wahl fiir Thre ImageView Kamera.

3. Driicken Sie die MODUS Taste und halten Sie diese gedriicke, bis sich die Kamera einschaltet. Die
Kamera schaltet nach etwa einer Minute automatisch ab, wenn keine Tasten gedriickt werden. Anmerkung:
Wenn die Kamera mit Hilfe des mitgelieferten USB Kabels an den Computer angeschlossen wird, wird die
Kamera automatisch mit Strom gespeist und iiber den Computer mit Strom versorgt, ohne dass die Batterie
entleert wird.

4. Halten Sie die ImageView Kamera in ciner stabilen Position und driicken Sie die Taste ,KNIPSEN* zur
Erstellung eines Fotos (oder Starten/Stoppen Sie die Aufnahme eines Videos, wenn sich die Kamera

im Video-Modus befindet). Die Brennweite der Kamera ist so voreingestellt, dass scharfe Aufnahmen aus
ciner Entfernung von ungefihr 35 Fuf§ bis unendlich aufgenommen werden kénnen.

5. Falls Sie ein Stativ verwenden, kénnen Sie die Auswirkungen des Verwackelns der Kamera dadurch
vermeiden, dass Sie den mitgelieferten Blendenausléser mit Fernbedienung in die Buchse neben dem
SD Kartenschlitz stecken und Thre Fotos lieber mit Hilfe des Fernbedienungsknopfs als mit der Taste
LKNIPSEN® erstellen.
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Verwendung der Betriebsarten/Einstellung von Datum & Uhrzeit

Die ImageView Kamera druckt Datum und Uhrzeit in den unteren rechten Rand Threr Fotos. Zur
Einstellung des aktuellen Datums und der aktuellen Uhrzeit nach Einschalten der Kamera driicken Sie
sowohl die MODUS Taste als auch die Taste ,KNIPSEN* gleichzeitig, bis das Display zu leuchten beginnt.
Auf dem Display erscheinen jetzt die letzten beiden Ziffern des Jahres. Driicken Sie die MODUS Taste und
bewegen den Cursor auf die zweite Ziffer, falls notwendig. Driicken Sie die Taste ,KNIPSEN“ und setzen
so die Ziffer nach vorne auf das aktuelle Jahr (,07“ fiir 2007, etc.) AnschlieSend driicken Sie die MODUS-
Taste, um zur nichsten Zahl, dem Monat, zu gelangen. Verwenden Sie wieder die Tast ,KNIPSEN® zur
Anderung der Anzeige auf den aktuellen Monat. Nach dem Monat erscheint auf dem Display: Datum,
Uhrzeit (24h FORMAT), Minute und Sekunde — stellen Sie diese Daten mit Hilfe des gleichen Ablaufs
ein und verwenden Sie dazu die MODUS-Taste und die Taste ,KNIPSEN®. Sobald Sie alle Datums-
und Uhrzeiteinstellungen abgeschlossen haben, leuchtet das Display nicht mehr auf und kehrt zum
Normalbetrieb zuriick. Beachten Sie bitte, dass nach dem Batteriewechsel ein Datums- und Uhrzeit-Reset
erforderlich ist. Thre ImageView Kamera erstellt unmittelbar nach ihrer Entnahme aus dem Etui Fotos mit
hoher Auflssung und hervorragender Qualitit und die Verwendung der MODUS-Einstellungen oder die
Durchfithrung von Anderungen jeglicher Art ist nicht erforderlich; zur Aufnahme Ihrer Fotos driicken Sie
cinfach die Taste ,KNIPSEN®. Wenn Sie jedoch einen Videoclip erstellen, ein vorhergehendes Foto oder
mehrere vorhergehende Fotos 16schen méchten, empfehlen wir Thnen, die auf den nachfolgenden Seiten
angegebenen, verfiigbaren Betriebsmodi durchzusehen. Durch kurzes Driicken der MODUS Taste kénnen
Sie diese Betriebsmodi in der aufgelisteten Reihenfolge durchtippen und es wird Thnen das Symbol fiir
jeden Betriebsmodus zusammen mit dessen aktueller Einstellung auf dem Display angezeigt. Driicken Sie
zur Auswahl der gewiinschten Einstellung fiir jeden Betriebsmodus die ,KNIPSEN* Taste. Wenn Sie keine
Anderungen vornehmen und innerhalb von 5 Sekunden weder die , KNIPSEN“ Taste noch die MODUS-
Taste gedriickt werden, kehrt die Kamera zum Normalbetrieb und zur normalen Displayanzeige zuriick.
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Bei Verwendung der Betriebsmodi (Fett werden die Voreinstellungen angezeigt)

Modus

Symbol

Einstellunge

Beschreibung

Video

Video Ka-
mera

AUS, Hoch
(640x480 Pixel pro
Rahmen, 15 fps),
Niedrig (320x240
Pixel)

Zur Einstellung des Video-Modus der Kamera
wihlen Sie "Hi" = Hoch (empfohlen) oder "Lo"
= Niedrig Video Auflssung anstelle von "AUS"
Warten Sie cinige Sckunden, bis das normale
Display der Kamera automatisch wieder angezeigt
wird, dann beginnen Sie mit der Aufnahme, indem
Sie auf KNIPSEN driicken. Der Zihler zeige die
verstrichene Zeit , oben bis hin zu 53 (Hoch) oder
die zweithéchste 132 (Niedrig) fiir jeden Videoclip
an. Zur Beendigung der Aufnahme erneut auf
KNIPSEN driicken. Der Zihler riickt um eine
Position vor und zeigt an, dass die Videodatei
gespeichert wurde. Kehren Sie zur Voreinstellung
Videomodus zuriick und wihlen Sie AUS fiir den
Reset der Kamera auf den unbewegten Fotomodus.

Qualitit

Hqor Lq

Hoch, Nicdrig

Wihlen Sie "Hohe" (empfohlen) oder “Niedrige”
Qualitit zur Auswahl des Ausmafles der Dateikom-
primierung, die sich auf die Gréfle  der Forodatei
auswirke. Die Einstellung "Niedrig” erméglicht die
Aufnahme ciner gréfleren Zahl an Fotos in den
Speicher, jedoch bei niedrigerer Qualitit.

Auflésung

Hi or Lo

Hoch (640x480
Pixel), Niedrig
(320x240 Pixel)

Wihlen Sie "Hohe" (empfohlen) oder "Niedrige”
Auflésung , je nachdem, ob Sie mehr Wert auf qual-
itativ hochwertigere Fotos legen (Hi=Hoch) oder ob
es Thnen wichtiger ist, cine gréfiere Anzahl an Fotos
aufnehmen zu kénnen (Lo=Niedrig).

57




Bei Verwendung der Betriebsmodi

Modus

Symbol

Einstellunge

Beschreibung

Linienfrequenz

60 oder 50

60 Hz, 50 Hz

Die Einstellung entspricht  der Nerzfrequenz
(Zyklenzahl) in Threm Land. So wird sichergestellt,
dass feststcechende Bilder und Videos, die bei
fluoreszierender Beleuchtung aufgenommen
wurden, normal erscheinen.

Gleich bleibend

CcT

AUS, 3, 5

Wihlen Sie 3 oder 5 Rahmen fiir die Aufnahme
einer schnellen Fotoserie anstelle eines.. einzelnen
Rahmens, wenn KNIPSEN gedriicke ist (im
herkémmlichen, feststehenden Fotomodus). Zum
Stornieren geben Sie erneut diesen Modus ein und
wihlen Sie AUS.

Speicher:
Zugang

MEM

STO (USB Mas-
senspeicher), PC
(USB Kamera)

Fiir den Zugang zum internen Speicher oder
Kartenspeicher wihlen Sie “Speicher: wenn die
Kamera mit Hilfe des USB Kabels an einen
Computer angeschlossen ist. "PC" ermglicht die
Benutzung der Kamera einer USB/PC Kamera fiir
bewegte Bilder (Bitte beachten Sie, dass die 8-fach
VergroRerung  und die fehlende Maglichkeit der
Nahfokusaufnahmen die Zweckmifigkeit in den
meisten groflen Riumen einschrinke)

Loschen Letzte

LSt
+Papierkorb

Kein- Foto-zum
Loschen des letzten
Fotos oder Videos
auf KNIPSEN
driicken.

Wihlen Sie diesen Betriebsmodus und driicken Sie
auf KNIPSEN, um ausschlielich das letzte von
Thnen aufgenommene Foto oder Video zu 16schen.
Die Zihleranzeige vermindert sich um eine Zahl.
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Bei Verwendung der Betriebsmodi

Modus

Symbol

Einstellunge

Beschreibung

Alles Léschen

ALL
+Papierkorb

Kein- Foto-zum
Léschen aller
Foto- und Video-
datcien KNIPSEN
driicken.

Zum Léschen des gesamten Speicherinhalts diesen
Betriebsmodus wihlen und KNIPSEN driicken:
(der Zihler wird auf Null zuriickgesetzr). Nach
dem Herunterladen Threr Datecien zum Léschen
des Speichers diesen Befehl verwenden: Sie kénnen
somit neue Fotos aufnchmen. Falls Sie unabsichtich
auf "Alles Léschen” gedriickt haben, warten Sie
cinfach ein paar Sekunden und die Kamera kehrt
zum Normalbetrieb zuriick.

Format

FOr
+Papierkorb

Kein Foto-driicken
Sie auf KNIPSEN
zum Formatieren

der Karte oder des
internen Speichers.

Bei Verwendung ciner neuen SD Karte oder ciner
SD Karte, die zuvor in anderen Geriten verwendet
wurde, empfehlen wir die Auswahl von FORMAT.
Vor dem Beginn Threr Foroaufnahmen driicken Sie
auf KNIPSEN, damit wird auf der Karte das kor-
rekte Dateiordnersystem fiir diese Kamera vorein-
gestellt. Bitte beachten Sie, dass die Formatierung
einer Karte deren Inhalt loscht — stellen Sie sicher,
dass Sie zuvor alle vorher aufgenommenen Dateien
gesichert haben.

Selbstausléser

Uhr

AUS oder Ein

Bei Betiitigung der Taste , KNIPSEN® wird das Foto
mit 10 Sekunden Verzégerung aufgenommen (im
herkémmlichen unbewegten Fotomodus). Damit
kann ein unbeabsichtigtes Verwackeln der Kamera
vermieden werden, wenn die Taste ,KNIPSEN®
gedriickt ist. Wenn das Blendenkabel fiir die
Fernbedienung verfiigbar ist, sollte es anstelle des
Selbstauslésers verwendet werden, wenn die Kamera
auf ein Stativ montiert ist. Der Selbstausléser 16sche
automatisch nach Gebrauch.
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VERWENDUNG DER IMAGEVIEW KAMERA MIT IHREM COMPUTER:

1. Die Kamera wird als ein USB Massenspeichergerit erkannt (bei Einstellung von "STO" anstelle von
"PC"), Dies bedeutet, dass fiir alle Betriebssysteme nach Windows 98 (Me,2000, XP) keine speziellen
Treiber erforderlich sind); die Betriebssysteme Mac BETRIEBSSYSTEM 9 und OSX sind ebenfalls
kompatibel. Wenn Sie Windows 98 benutzen, miissen Sie den Treiber entsprechend der beigefiigten
CD-ROM installieren, BEVOR Sie DIE KAMERA AN IHREN PC ANSCHLIESSEN.

2. Wenn das Betriebssystem IThres Computers, wie oben aufgefiihrt, mit einem USB Massenspeicher
kompatibel ist, erscheint ein neues CD Symbol im Windows Explorer (unter “Arbeitsplatz®) als neuer
“Wechseldatentriger”, nach Anschluss des USB Kabels der Imageview Kamera. Bei Mac Anwendern
erscheint das neue CD Symbol auf dem Desktop. Durch einen Mausklick auf das neue CD Symbol
wird der Inhalt, eine ,DCIM* Datei, angezeigt. Die darin enthaltene Bilddatei beinhaltet Ihre Fotos,
gespeichert als JPEGs (.jpg Dateiformat). Sie kénnen mit Hilfe jeglicher Photo- oder Graphiksoftware,
die .jpg Dateien verarbeiten kann, gedffnet, bearbeitet, umbenannt und gespeichert werden. Wenn Sie
{iber keine entsprechende Software zum Offnen von .jpg Dateien verfiigen, empfehlen wir die Installation
der MGI Photosuite Software (nur Windows) aus der beigefiigten CD-ROM. Die Anweisungen dazu
entnehmen Sie bitte dem Kapitel , Software-Installation®.

3. Nach dem Kopieren oder Offnen und Speichern der Fotodateien auf die Festplatte Thres Computers
kénnen Sie die Imageview Kamera vom Computer trennen (NIEMALS die Kamera trennen, wihrend
die Ubertragung von Dateien auf Thren Computer noch liuft). Vor dem Trennen sollten Sie den
Wechseldatentriger der Kamera aus dem Laufwerk “auswerfen” oder stoppen, um die Ausgabe einer
Fehlermeldung zu vermeiden (nicht erforderlich mit Windows XP).

4. Auf den nachfolgenden Seiten erhalten Sie cine vollstindige Beschreibung der einzelnen Schritte fiir das
Herunterladen Threr Fotos.
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Systemanforderungen (Mindestanforderungen)

Betriebssystem Windows® 98/98SE/2000/ME/XP

CPU: gleichwertig zu MMX Pentium® 200MHZ oder schneller (Pentium® IIT 500 MHz fiir PhotoSuite5™)
Speicher: mindestens 32MB (64MB empfohlen fiir PhotoSuite) SVGA Videokarte w/2MB VRAM, 800x600
Bildschirmanzeige, 16 bit High color) verfiigbarer Festplattenspeicher 200 MB (bei Installation von Photosuite)
Interner USB-Port

Software-Installation

Wenn Sie Windows 98 benutzen, miissen Sie Treiber installieren, bevor Sie die Kamera an Thren PC anschlieflen.
Legen Sie die CD-ROM in das CD-ROM Laufwerk Thres Computers ein; Das Programm fihrt automatisch hoch
und das Installationsbild wird angezeigt. Wahlen Sie ,Install Driver” (Treiber installieren) und befolgen Sie dann die
Anweisungen. Starten Sie nach der Installation Thren Computer neu. Windows 2000, ME und XP benétigen keine
Treiber, da die Kamera den USB-Massenspeicher Standard benutzt, was den Zugriff auf die Fotodateien erméglicht,
als ob sie auf ciner externen Festplatte gespeichert wiren. Wenn Sie noch keine bestimmte Fotobearbeitungs-
software verwenden, so kénnen Sie fiir jedes beliebige Windows-Betriebssystem Roxio PhotoSuite® von der CD-
ROM installieren. Lesen Sie auf jeden Fall die ,Release Notes” (Freigabe-Anmerkungen) vollstindig, da diese Tipps
enthalten oder mégliche Probleme ansprechen, die Thre PC-Konfiguration und Ihr Betriebssystem betreffen.

WARNHINWEIS: Stellen Sie sicher, dass Sie vor dem Entfernen der
Batterien aus der Kamera alle Bilder von Ihrer Kamera herunter laden

Ubertragung von Fotos und Videos auf Thren PC - Schritt fiir Schritt

1. Vergewissern Sie sich, dass zuerst der Treiber installiert wurde, wenn Sie mit Windows 98/98SE arbeiten.

2. Verbinden Sie das mitgelieferte Kabel mit dem USB-Port des ImageView und dann direke mit dem Haupt-USB-
Port an Threm Computer — benutzen Sie keine USB-Ports auf der Frontplatte/Tastatur oder ,Hubs“ ohne cigene
Stromversorgung.
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Ubertragung von Fotos und Videos auf Thren PC

3. Auf der LCD-Anzeige erscheint ,Mass Storage” (Massenspeicherung), und der ImageView wird als
cin standardmifiges ,USB-Massenspeichergerit® erkannt. Das bedeutet, dass die Kamera-Dateien
leicht angezeigt, bearbeitet oder auf Thre Festplatte kopiert werden kénnen, genau wie wenn sie auf
ciner externen Festplatte oder einer CD-ROM gespeichert wiren.

4. (Dieser Schritt ist bei Windows XP nicht erforderlich, benutzen Sie einfach die Optionen im Pop-up-
Fenster zum Anzeigen, Kopieren oder Bearbeiten IThrer Fotos). Offnen Sie Arbeitsplatz oder Windows
Explorer. Die Kamera erscheint als ein neuer “Wechseldaten-triger® mit einem ihr zugewiesenen
unbenutzten Laufwerk-Buchstaben. Doppelklicken Sie auf dieses neue ,,Gerit-Symbol“, 6ffnen Sie den
darin enthaltenen ,DCIM”-Ordner und dann den (die) in diesem enthaltenen Ordner (,100MEDIA”
usw). Thre Fotos/Videos sind die darin enthaltenen Dateien — sie tragen den Prifix ,IMG__“, gefolgt
von einer Zahl - derselben, die vorher beim Anzeigen der Fotos auf der Anzeige der Kamera zu sehen
war. Bei einem einzelnen Klick auf eine Datei sollte ein kleines Kontrollbild gezeigt werden.

5. Klicken Sie auf ,,Bearbeiten > Alle auswihlen“ (oder klicken Sie auf ein einzelnes Foto, oder auf
Strg+Klick, um mehrere Fotos auszuwihlen), dann “ auf ,Bearbeiten > In Ordner kopieren® (in
Windows-Meniis). Wihlen Sie einen bestehenden Ordner auf Threr Festplatte, wie etwa ,Eigene
Bilder“, oder erstellen Sie einen neuen Ordner (,,Hawaii-Urlaub“ usw.) und klicken Sie dann auf ,,OK“,
um die Kopien der gewiinschten Fotodateien. zu iibertragen.

6. Nach Ubertragung der Fotos auf lhre Festplatte kdnnen Sie die Kamera abkoppeln. Windows 2000
zeigt méglicherweise eine Warnung an, dass Sie ein USB-Gerit abgehiingt haben, ohne das Gerit zuvor
deaktiviert oder ausgeworfen zu haben (Thre Fotodateien werden dadurch nicht beschidigt). Sollte das
der Fall sein, so kennzeichnen Sie das Kontrollkistchen, das zu Threr Systemleiste oder Taskleiste ein
Symbol hinzufiigt. Dann kénnen Sie beim nichsten Mal, wenn Sie mit der Ubertragung von Fotos
fertig sind, erst auf dieses Symbol und dann “ auf ,,USB-Massenspeichergerit auswerfen® klicken,
bevor Sie die Kamera abkoppeln. (Bei Mac-Computern miissen Sie die CD ,auswerfen®, die auf Threm
Desktop erschien, als die Kamera angeschlossen war.)
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Ubertragung von Fotos und Videos auf Thren PC

7. Jetzt kénnen Sie die Fotodateien in jeder beliebigen Foto-Bearbeitungssoftware 6ffnen. Benutzen Sie einfach nur
Datei>Offnen und gehen Sie zu dem Ordner, in dem Sie die Fotos zuvor abgelegt haben. Wenn Sie PhotoSuite
benutzen, wihlen Sie Datei>Foto éffnen, und benutzen Sie dann ,Suchen in“ oben im ,Offnen-Fenster, wihlen
Sie ,Arbeitsplatz®, dann Thre Festplatte, und doppelklicken Sie auf irgendein Foto in dem Ordner, in den Sie die
Dateien von der Kamera kopiert haben. Sie kénnen Thre Fotos auch direkt von ImageView aus 8ffnen und mit ihnen
arbeiten, solange dieses noch angeschlossen ist. Um dies mit PhotoSuite zu tun, fithren Sie erst die Schritte 1 -3 aus,
ffnen Sie dann PhotoSuite, wihlen Sie Datei>Foto 6ffnen und benutzen Sie dann ,Suchen in®, um , Arbeitsplatz*
auszuwihlen, wihlen Sie dann ,Wechseldatentriger* und éffnen Sie die darin enthaltenen Ordner, bis Sie zu den
JPEG-Fotodateien gelangen. Wenn Sie sich entscheiden so vorzugehen, von der angeschlossenen Kamera aus, dann
achten Sie darauf, dass Sie das Foto auf IThre Festplatte speichern (wenn Sie es bearbeitet haben), und nicht auf die
Speicherkarte der Kamera. Um dies mit PhotoSuite zu tun, antworten Sie nach dem Klick auf ,Fertig" auf die Frage
,Anderungen speichern?* mit ,Ja“, antworten Sie jedoch auf die Frage ,Bereits existierende Datei ersetzen? mit
,Nein“ und benutzen Sie das Dialogfenster ,Speichern unter”, um das bearbeitete Foto in einen Ordner auf Threr
Festplatte zu speichern (,Speichern unter>lokale Festplatte®), nicht auf dem ,, Wechseldatentriger (Kamera).

8. Wenn Sie mit der Fotobearbeitung auf dem Computer noch keine Erfahrung haben, so befragen Sie das Hilfemenii
Threr Software (PhotoSuite verfiigt eine umfangreiche eingebaute Hilfe) nach Tipps fiir die Benutzung seiner
Funktionen. Neben der Einstellung von Helligkeit, Kontrast, Schirfe und Farbe Threr Fotos knnen Sie auch die
Grofe eines Fotos an das Papier anpassen, wenn Sie drucken, oder Sie kénnen eine Version mit geringerer, niedriger
oder mittlerer Aufldsung speichern, um Sie als E-Mail zu verschicken oder in Dokumente einzufiigen. Wenn Sie soweit
sind, dass Sie Ihre bearbeitete Datei speichern kénnen, dann méchten Sie vielleicht ,Speichern unter” benutzen und
der Datei einen aussagekriftigeren Namen geben als “IMG___". Dabei bleibt die Originaldatei als Sicherungskopie
erhalten und kann spiter wieder gedffnet und erneut bearbeitet werden. Vergewissern Sie sich, dass Sie alle Fotos,
die Sie speichern wollten, erfolgreich iibertragen haben, bevor Sie bei Threr Kamera ,Delete All” (alles Ldschen)
anwenden, um Platz fiir neue Bilder zu schaffen.
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BEDIENUNGS-ANLEITUNG FERNGLAS

Thr Bushnell Fernglas ist ein Prizisionsinstrument, das Ihnen viele Jahre lang Freude am Betrachten
bietet. Dieses Kapitel der Broschiire ermdglicht Thnen das Erreichen optimaler Leistungen durch
Erliuterungen zur Abstimmung des Fernglases auf Thre Augen und mit Hilfe von Hinweisen zur
Wartung dieses Instruments. Lesen Sie bitte diese Bedienungsanleitung vor dem Gebrauch Ihres
Fernglases sorgfiltig durch.

AUGENEINSTELLUNGEN (Abbildung 1)

Einstellung des Abstands zwischen ihren Augen
Der Abstand zwischen den Augen, auch “Pupillendistanz” genannt, ist
von Person zu Person unterschiedlich. Zur Erreichung eines perfekten
Abgleichs zwischen Linse und Auge befolgen Sie diese einfachen PUPILLENDISTANZ
Schritte.

1. Halten Sie Thr Fernglas in der normalen Sichtposition.

2. Umgreifen Sie jedes Sichtrohr fest. Bewegen Sie die Sichtrohre niher
zusammen oder weiter auseinander, bis ein einzelnes, kreisformiges Feld erscheint. Stellen Sie Thr

Fernglas vor dem Gebrauch immer wieder auf diese Position ein.

Wie erfolgt die Einstellung auf die individuelle Sehschirfe
Da sich die individuelle Sehkraft von einer Person zur anderen unterscheidet, sind die meisten Bushnell

Ferngliser mit einer Dioptrien-Einstellung ausgeriistet Ein Merkmal, das die Feineinstellung des Fernglases
entsprechend Threr Sehkraft erméglicht. Befolgen Sie die unten aufgefiihrten Anweisungen zur Einstellung
der Bildschirfe fiir Thren Fernglas Typ.
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EINSTELLUNG DER BILDSCHARFE

1. Pupillendistanz einstellen. (Abbildung 1)

2. Die “Dioptrien-Einstellung” (Abbildung 2) auf Null setzen und einen
entfernten Gegenstand betrachten.

3. Stets beide Augen gedffnet halten.

4. Mit Hilfe einer Linsenabdeckung oder Threr Hand decken Sie das
Objektiv (vordere) Linse der gleichen Seite des Fernglases ab, an der die _;“WIWM

]

“Dioptriencinstellung” angebracht ist. Normalerweise ist dies die rechte
Seite. (Die linke Seite bei Modellen mit Zoom.)

5. Das Fokussier-Ridchen in der Mitte dient der Scharfeinstellung eines
entfernten Gegenstandes mit feinen Details (z.B. Ziegelwand, Baumiste, etc.), bis dieser so scharf wie
maéglich erscheint.

6. Entfernen Sie die Abdeckung der Objektivlinse auf der Dioptrien-Seite, decken Sie die andere
Objektivlinse ab, dann betrachten Sie den gleichen Gegenstand.

7. Mit Hilfe des Verstellrings fiir die “Dioptrien-Einstellung” nehmen Sie die Scharfeinstellung
des gleichen betrachteten Gegenstands vor. Bitte vorsichtig vorgehen, da ein Uberdrehen oder

DIOPTRIEN-EINSTELLUNG

erzwungenes Betitigen der Dioptrien-Augenmuschel Beschidigungen zur Folge hat oder dazu fiihrt,
dass die Augenmuschel vom Gestell abbricht.

8. Einstellung der Fernglasoptik auf Thre Augen. Die Fokussierung aller weit entferntenoder nahe
liegenden Entfernungen ist jetzt ganz einfach durch Drehen des Fokussier-Ridchens in der Mitte
maéglich. Notieren Sie die Dioptrieneinstellung fiir Ihre Augen als zukiinftigen Anhaltspunkt.

AUGENMUSCHELN (Abbildung 3)
Thr Bushnell Fernglas ist mit abrollbaren Gummi-Augenmuscheln fiir Thren
Komfort und zum Schutz vor von auflen eindringendem Licht ausgeriistet.

N 0
Wenn Sie eine Sonnenbrille/Brille tragen, rollen Sie die Augenmuscheln nach [ ]

L
[ ——ili~——=—]

. Dies i Abs ischen Th A F las
unten. Dies verringert de_n bstand zwischen lhren Augen und dem Fernglas [ ——PlH——"
und bietet Thnen somit ein verbessertes Sehfeld. ROLL-DOWN EYECUPS
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GEBRAUCHS- ANWEISUNG FUR DIE PFLEGE DES FERNGLASES
Thr Bushnell Fernglas wird jahrelang stérungsfrei funktionieren, wenn Sie die herkémmlichen
Pflegearbeiten durchfiihren, die fiir jedes optische Feininstrument iiblich sind. Das Imageview Gerit
ist nicht wasserdicht und sollte keinerlei Feuchtigkeit ausgesetzt werden. Die Gewihrleistung decke
keinerlei Wasserschiden ab.

. Falls Ihr Fernglas iiber abrollbare, flexible Augenmuscheln verfiigt, bewahren Sie es mit den
Augenmuscheln nach oben auf. So wird tibermiflige Beanspruchung und Verschleify an den
Augenmuscheln in der nach unten gerichteten Position vermieden.

—

2. Nicht gegen das Fernglas schlagen oder das Fernglas auf den Boden werfen.

3. An cinem kiihlen, trockenen Platz aufbewahren.

4. WARNHINWEIS: Direktes Betrachten der Sonne durch Ihr Fernglas kann zur dauerhaften
Schidigung Ihrer Augen fithren.

5. Bringen Sie Ihr ImageView Fernglas nie mit einer gréfleren Menge an Fliissigkeit oder eines
Fliissigmediums in Kontakt, da es nicht wasserdicht/ nebel abweisend ist.

6. Entfernen Sie die Batterien aus Threm ImageView Gerit, wenn Sie dieses wihrend eines lingeren

Zeitraums nicht benutzen. (Stellen Sie sicher, dass Sie alle Bilder von Threr Kamera herunterladen,
bevor Sie die Batterien aus der Kamera entfernen.)

REINIGUNG

1. Blasen Sie jeglichen Staub oder Schmutzpartikel von der Linse (oder verwenden Sie eine weiche
Linsenbiirste.)

2. Zur Entfernung von Verschmutzungen oder Fingerabdriicken verwenden Sie ein weiches Baumwolltuch
und fithren damit kreisende Bewegungen aus. Die Verwendung eines rauen Tuchs oder unnétiges
Reiben kann die Oberfliche der Linse verkratzen und méglicherweise dauerhafte Beschidigungen
verursachen. Ein “Mikrofaser” Reinigungstuch (erhiltlich in den meisten Fotoliden) ist ideal
geeignet fiir die routinemiflige Reinigung Ihres optischen Gerites.

3. Zur griindlicheren Reinigung verwenden Sie ein Tuch fiir die Fotolinsen und eine Reinigungsfliissigkeit
fiir Fotolinsen oder Isopropyl-Alkohol. Tragen Sie die Fliissigkeit immer zuerst auf das Reinigungstuch

auf — nie direkt auf die Linse.
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IGEWAHRLEISTUNGSFRIST ZWEI JAHRE

bf das von Thnen erworbene Produkt der Firma Bushnell® gewihren wir eine zweijih-

Anmerkung bezuglich FCC Richthnien: |
Dieses Gerit wurde getestet und es wurde als mi
den Vorschriften fiir ein digitales Gerat der Klasse

ige Garantie auf Materialmiingel und Verarbeitung, giiltig ab dem K. Falls

ahrend dieser Garantiezeit ein Mangel auftreten sollte, behalten wir uns die Entsche-
dung dariiber vor, das Produkt zu reparieren oder zu ersetzen, unter der Voraussetzung,
dass der Kunde das Produkt porto- und an uns zuriickschickt. Diese
Gewihrleistung schliefit keinerlei Schaden ein, die durch Missbrauch, unsachgeméfien
Umgang, Einbau oder durch fehlerhafie Wartung verursacht wurden, und gilt cbenfalls

B iib d befunden, gemiss Teil B dei
FCC Vorschriften. Diese Vorschriften wurder
entwickelt, um innerhalb eines Wohnhauses einer
verniinftigen Schutz vor gefihrlichen Interferenzen|
2u gewahrleisten. Dieses Gerit erzeugt und verwende

icht, wenn diese Titigkeiten von anderen Personen als den durch die Kund

und kann diese ausstrahlen|

eilung der Firma Bushnell hierfiir autorisierten Personen durchgefiihrt wurden.

egliche Riicksendung, die in bezug auf diese Gewihrleistung erfolgt, muss folgende
Begleitpapiere enthalten:
1) Einen Scheck/Bargeld in Hohe von $10.00 fiir die Porto- und Handlingkosten

Name und Adresse fiir Riicksendung des Produkts

Eine genaue Erlduterung des Mangels

hadi

und, wenn dieses nicht in Ubereinstimmung mit de:
Bedienungsanleitung eingesetzt wird, kann es den
Rundfunkverkehr empfindlich storen. Es gibt jedoch|
keinerlei Garantie dafiir, dass die Storung in eine:
bestimmten Einrichtung nicht auftritt. Wenn diese:
Gerit storende Auswirkungen auf den Radio- ode
Fernsehempfang haben sollte, die durch Aus- un

)
3)
4) Beleg des Kaufdatums
5) Das Produktist in einem stabilen Versandkarton gut zu verpacken, um By
‘Transport zu vermeiden, die Portospesen fiir den Versand an nachstehend aufgefiihrte
Adresse sind im Voraus zu entrichten:
Versandadresse fiir die U.S.A.: Versandadresse fiir Kanada:
Bushnell Outdoor Products
¢.H.: Reparaturabteilung
B500 Marshall Drive
[Lenexa, Kansas 66214

Bushnell Outdoor Products

2.H. Reparaturabteilung

25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

as Produkte anbelangt, die nicht in den U.S.A. oder in Kanada gekauft wurden, erfra-
ken Sie bitte die gilltigen Garantiebedingungen bei Ihrem értlichen Hindler. Innerhalb
Europas kann die Firma Bushnell unter folgender Adresse kontaktiert werden:
BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 KOLN

DEUTSCHLAND

Tel: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Diese Gewihrleistung riumt Thnen besondere juristische Rechte ein.
Fiir die jeweiligen Linder gelten moglicherweise linderspezifische Rechte.
©2006 Bushnell Outdoor Products

halten des Gerites lit werden kénnen, is
es fiir den G maglich, eine Behebung del
Storung mit Hilfe einer oder mehrerer der folgend

Mafinahmen zu erreichen:

- Neuausrichtung ~ oder  Neuplatzierung  de:
Empfangsantenne.
- Das Gerit mit einem Ausgang eines Netze

verbinden, das in keinerlei Verbindung zu dem Net7
steht, womit der Receiver verbunden ist.

- Pragen Sie den Fachhindler oder einen erfahrenen|
Radio- oder Fernsehtechniker um Rat.

Unter Beachtung der Vorschriften fiir ein digitale:
Gerit gemif Unterartikel B des Abschnitts 15 der FCt
Richtlinien ist ein abgeschirmtes Interface-Kabel mit
dem Gerit zu verwenden.

Der Hersteller behilt sich das Recht auf die
Durchfithrung von Anderungen von Spezifikationen|
und Konstruktionsmerkmalen ohne jegliche vorherigd
Ankiindigung oder Verpflichtung vor.

€
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AVVERTENZA

Ricordarsi di scaricare le foto dalla fotocamera PRIMA di rimuovere o cambiare
le pile, a meno che le foto non siano state memorizzate su una card SD invece
che nella memoria interna della fotocamera. Prima di riporre I'TmageView se non
viene usata una card SD nella fotocamera, si raccomanda di scaricare e conservare
tutti i file delle foto correnti, per evitare che detti file vadano perduti nel caso in
cui le pile si dovessero scaricare durante un lungo arco di tempo di inattivita.

AVVERTENZA

NON guardare direttamente al sole attraverso il binocolo.
Gli occhi potrebbero subire danni permanenti.

NOTA: Per azzerare la fotocamera in caso di problemi o se il display non
risponde, rimuovere le pile per almeno un minuto, quindi installarle di nuovo.
Cio pué causare la perdita di ogni foto/video conservati nella memoria interna.
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ITALIANO

Grazie per la preferenza accordataci acquistando il binocolo Bushnell
ImageView®! 1l binocolo Bushnell ImageView abbina la tecnologia
della fotografia digitale ad un binocolo compatto di alta qualita. Cid
permette di osservare avvenimenti sportivi, selvaggina, panorami
o qualsiasi cosa per la quale si pensi di usare un binocolo, e quindi
salvare I'immagine in una fotocamera digitale incorporata allegata al
binocolo. E possibile quindi scaricare le immagini sul computer e
spedirle tramite email ad amici e parenti, stampare le immagini usando
l'accluso software o salvatle in un album ed usarle in futuro. Prima di
usare il prodotto, leggere le istruzioni contenute nel presente manuale
e familiarizzarsi con le diverse parti e caratteristiche funzionali del

prodotto.
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Guida alle parti della

fotocamera e del binocolo

Presa Slot della  Porta
remota  card USB

Zoccolo per

treppiede

Vano delle pile

|

Messa a Pulsante Pulsante (si apre facendolo
fuoco del SNAP  Obiettivo MODE scorrere nella
binocolo della 4 direzione della
fotocamera freccia)
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Preparazione della fotocamera e funzionamento di base

1.La fotocamera ¢ alimentata da due pile alcaline AAA, al litio o NiMh (non incluse). Inserire le pile
nel vano apposito, con le molle che toccano il polo negativo (estremita piatta) di ogni pila. Un misuratore
della potenza al centro a sinistra del display indica la carica delle pile.

2. Se si desidera una maggiore capacita di memoria, inserire una Card SD (‘alla rovescia” con i contatti di
metallo rivolti in alto). E possibile usare Card SD (non MMC card) fino a 1 GB di capacitd. La fotocamera
ha una memoria interna di 8 MB capace di contenere piu di 100 foto; pertanto, la card non ¢ necessaria.
Tuttavia, il contenuto della memoria interna andra perduto se le pile vengono rimosse o sono completamente
scariche, a differenza delle foto memorizzate su una Card SD. Card con velocita standard da 256 MB sono
disponibili presso la maggior parte dei negozi di prodotti elettronici o di computer, e sono una buona
soluzione per I'ImageView.

3. Premere e tenere premuto il pulsante MODE fino a quando la fotocamera si accende. La fotocamera
si accenderd automaticamente dopo circa un minuto se non viene premuto alcun pulsante. Nota:
quando ¢ collegata a un computer tramite il cavo USB (fornito in dotazione), la fotocamera si accendera
automaticamente e si alimentera dal computer, risparmiando la carica delle pile.

4. Tenere fermo I'ImageView e premere SNAP per scattare una foto (oppure per avviare/fermare un video,
quando la fotocamera ¢ in modo video) La messa a fuoco della fotocamera ¢ prefissata per prendere foto
nitide da circa 10 metri all'infinito.

5. Quando viene usato un treppiede, per evitare gli effetti causati dall’oscillazione della fotocamera, collegare
lotturatore remoto, fornito in dotazione, alla presa vicina allo slot della Card SD, e usare il pulsante
dell’otturatore remoto invece del pulsante SNAP per prendere le foto.
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Uso dei modi operativi/Impostazione della data e dell’ora
ImageView stampa la data e I'ora nell’angolo in basso a destra delle foto. Per impostare la
data e I'ora, dopo aver acceso la fotocamera, premere e tenere premuti contemporaneamente i
pulsanti MODE e SNAP, fino a quando il display comincia a lampeggiare. Il display mostra ora
le ultime due cifre dell’anno. Premere il pulsante MODE per spostare il cursore alla seconda
cifra, se necessario. Premere il pulsante SNAP per scorrere la cifra all’anno corrente (“07”per
2007, ecc.). Premere quindi MODE per passare al numero successivo, cio¢ al mese. Di nuovo,
usare SNAP per cambiare il numero al mese corrente. Dopo il mese, sul display appare: data,
ora (formato delle 24 ore), minuti e secondi — continuare a impostare queste cifre seguendo la
stesso procedura usando i pulsanti MODE e SNAP. Una volta completate tutte le impostazioni
della data e dell’ora, il display cessa di lampeggiare e torna allo stato normale. Si ricorda che la
data e I'ora devono essere impostate di nuovo dopo aver cambiato le pile.

LImageView viene consegnato gid impostato per una risoluzione e una qualith ottima delle
immagini; non & necessario usare le impostazioni di MODE e fare cambiamenti: buoni
risultati si ottengono semplicemente premendo il pulsante SNAP per scattare le foto. Tuttavia,
quando si desidera riprendere un breve filmato video, cancellare una o piti foto o esplorare altre
opzioni, si raccomanda di rivedere le opzioni dei modi disponibili elencate alle pagine seguenti.
Premendo brevemente il pulsante MODE, il display mostra, nell’ordine di seguito indicato,
questi modi operativi, e di ogni modo si vedra la relativa icona e 'impostazione corrente.
Usare il pulsante SNAP per selezionare I'impostazione desiderata di ogni modo. Se non viene
fatta alcuna modifica, e il pulsante SNAP o MODE non viene premuto entro 5 secondi, la
fotocamera torna al funzionamento e al display normale.
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Uso dei modi operativi

(le impostazioni predefinite sono indicate in grassetto)

(320x240 pixel)

Modo Icona Impostazioni Descrizione
Video Video OFF, Alta Selezionare la risoluzione video “Hi” (consigliata)
Camera (640x480 pixel o “Lo invece di “OFF” per mettere la camera in
per fotogramma, modo video. Attendere alcuni secondi prima che
15fps), Bassa la fotocamera torni automaticamente al display
(320x240 pixel) normale, quindi cominciare le riprese premendo
SNAP. I contatore visualizzera il tempo trascorso,
fino ad un massimo di 53 (Hi) 0132 secondi per
ogni filmato. Premere di nuovo SNAP per cessare
la ripresa video. Il contatore indichera uno,
significando che il file video ¢ stato salvato. Tornare
all'impostazione del modo video e selezionare OFF
per riportare la fotocamera al modo fotografico.
Qualita Hqo Lq Alta, Bassa Selezionare la qualitd “Hi” (consigliata) o “Lo” per
selezionare I'entita della compressione dei file, che
influiscesulle dimensioni del file delle foto. “Lo”
permette di memorizzare una maggiore quantita di
foto, se pure a qualita ridotta.
Risoluzione Hio Lo Alta (640x480 Selezionare la risoluzione “Hi” (consigliata) o “Lo”,
pixel), Bassa in base alle preferenze personali per foto di aspetto

migliore (Hi) o per scattare una quantita di foto
maggiore (Lo).
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Uso dei modi operativi

Modo Icona Imp ioni Descrizi
Frequenza di 60 0 50 60 Hz, 50 Hz Impostare la frequenza sulla frequenza della potenza
rete CA (cicli) del proprio paese. In tal modo, la foto e i

video appaiono normali in presenza di illuminazione
a ﬂuorescenza.

Continuo CT OFF, 3,5 Selezionare 3 o 5 fotogrammi per scattare una serie
rapida di foto invece di un singolo fotogramma,
quando viene premuto SNAP (nel modo normale
foto da fermo). Per annullare, accedere di nuovo

a questo modo e selezionare OFE.

Accesso alla MEM Sto (memoria di Selezionare “Sto” per accedere alla memoria interna
memoria massa USB), PC o alla card quando la fotocamera ¢ collegata a un
(fotocamera USB) | computer con il cavo USB. "PC" permette di usare
la fotocamera come una fotocamera USB/PC dal
vivo (notare che I'ingrandimento 8x e I'incapacita
di messa a fuoco ravvicinata limita I'utilita di questa
impostazione nella maggior parte degli ambienti)

Cancella ultima | LSt +Cestino | Nessuna-premere Selezionare questo modo e premere SNAP per
SNAP per cancellare solo I'ultima foto scattata o l'ultima
cancellare I'ultima | ripresa video. Il contatore scendera diun numero.
foto o I'ultimo
video
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Uso dei modi operativi

Modo Icona Impostazioni Descrizione
Cancella tutto ALL Nessuna-premere Selezionare questo modo e premere SNAP per
+Cestino SNAP per cancellare l'intero contenuto della memoria (il
cancellare tutti i contatore si azzera). Dopo aver scaricato i file, usare
file delle foto e dei | questo modo per liberare la memoria in modo da
video poter scattare nuove foto. Se “Cancella tutto” viene

selezionato per sbaglio, attendere alcuni secondi ¢ la
fotocamera torna al funzionamento normale.

Formatta FOr Nessuno- premere | Se viene usata una nuova card SD, oppure una card
+Cestino SNAP per gid usata in altri dispositivi, si consiglia di selezionare

formattare la card | Formatta e premere SNAP prima di scattare le foto,

o la memoria in modo che la card ¢ configurata con il sistema di

interna file corretto per questa fotocamera. Si noti che la

formattazione di una card cancella il suo contenuto-
accertarsi di aver fatto prima una copia di tutti i file.

Autoscatto Orologio OFF o On La foto viene scattata dopo un ritardo di 10
secondi quando viene premuto SNAP (nel modo
normale foto da fermo). Questo modo puo essere
usato per evitare che la fotocamera venga scossa
accidentalmente quando si si preme SNAP Se il
cavo dell’otturatore a distanza ¢ disponibile, si
consiglia di usarlo al posto dell'autoscatto quando
la fotocamera ¢ montata sul treppiede. Il timer si
annulla automaticamente dopo 'uso.

75



USO DI IMAGEVIEW CON IL COMPUTER:

1. La fotocamera verrd riconosciuta come dispositivo USB di memoria di massa (se ¢ impostata su
"STO", non su "PC"), il che significa che non ¢ richiesto alcun driver speciale per ogni sistema
operativo successivo a Windows 98 (Me, 2000, XP). Sono anche compatibili i sistemi operativi
Mac OS 9 e OSX. Se il PC usa Windows 98, ¢ necessario installare il driver incluso nel CD-ROM,
PRIMA DI COLLEGARE LA FOTOCAMERA AL PC.

2. Se il sistema operativo del proprio computer ¢ uno di quelli sopra elencati che ¢ conforme alla
memoria di massa USB, una nuova icona del disco apparird in Esplora Risorse (in “Risorse del
computer”) come un nuovo “Disco rimovibile”, dopo aver collegato il cavo USB da ImageView.
Gli utenti Mac vedranno apparire sul desktop il nuovo dispositivo a disco. Cliccando sull'icona
del nuovo disco, appariri il contenuto, una cartella chiamata “DCIM”. La cartella delle immagini
contiene le foto, memorizzate come JPEG (formato dei file .jpg). I file delle foto possono essere
aperti, modificati, cambiati di nome e salvati usando un software fotografico o grafico che accetta
i file .jpg. Se il software che apre i file .jpg non ¢ disponibile, installare MGI Photosuite (solo per
Windows) dall’accluso CD-ROM. Per istruzioni, vedere “Installazione del software”.

3. Dopo aver copiato o aperto e salvato i file delle foto sul disco rigido del computer, scollegare la
fotocamera di ImageView (NON scollegare MAI la fotocamera mentre i file vengono trasferiti
al computer). Per evitare messaggi di errore, prima di scollegare, “espellere” o fermare il disco
rimovibile rappresentante la fotocamera (non necessario con Windows XP).

4. Vedere alle pagine seguenti le istruzioni ordinate su come scaricare le foto.
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Requisiti di sistema (minimo)

Sistema operativo Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ equivalente o pitt veloce (Pentium® ITT 500 MHz per PhotoSuite5™)
Memoria: 32MB minimo (64MB consigliati per PhotoSuite)

Scheda video SVGA con 2MB di RAM, display 800x600, alta colorazione a 16 bit

200 MB di spazio disponibile sul disco rigido (se viene installato PhotoSuite)

Porta USB interna

Installazione del software

Se viene usato Windows 98, prima di collegare la fotocamera al PC ¢ necessario installare i driver. Inserire il CD-
ROM nel lettore di CD del computer; si avvierd automaticamente ¢ apparira la schermata dell'installazione. Selezion-
are “Install Driver”, quindi seguire le istruzioni. Terminata l'installazione, riavviare il computer. Windows 2000, ME
e XP non richiedono i driver, poiché la fotocamera usa lo standard USB della memoria di massa, permettendo di ac-
cedere alle foto come se queste fossero memorizzate su un disco rigido esterno. Per ogni sistema operativo Windows,
se al momento non viene usato un qualsiasi software per I'elaborazione delle immagini, ¢ possibile installare Rodio
PhotoSuite” dal CD-ROM. Leggere completamente le “Relegasse Notes”, osservando ogni consiglio o problema
potenziale importante per la configurazione e il sistema operativo del PC.

AVVERTENZA: Ricordarsi di scaricare ogni foto
dalla fotocamera prima di rimuovere le pile.

Trasferimento di foto e video al PC - Procedura ordinata
1. Se viene usato Windows 98/98SE, verificare che il driver sia stato installato.
2. Collegare il cavo in dotazione alla porta USB di ImageView, quindi direttamente ad una porta USB principale del
computer-non usare le porte USB sul pannello frontale o sulla tastiera, né su “pub” non alimentati.
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Trasferimento di foto e video al PC

3. Il display LCD mostrerd “STO”, e ImageView sara riconosciuto come un “dispositivo di memoria
di massa USB” standard. Questo significa che i file della fotocamera possono essere facilmente visti,
modificati o copiati sul disco fisso come se fossero memorizzati su un disco fisso esterno o su un CD-

ROM.

4. (Questa operazione non ¢ necessaria con Windows XP: basta usare le opzioni visualizzate sullo schermo
per vedere, copiare o modificare le foto). Aprire Esplora Risorse o Risorse del Computer. La fotocamera
sara rilevata come un nuovo “Disco rimovibile” e gli verra assegnata una lettera di unita non utilizzata.
Fare doppio clic sull’icona di questo nuovo “Disco”, aprire la cartella “DCIM” all'interno, quindi le
cartelle all’interno di detta cartella (“100MEDIA”, ecc.). Le foto e i video sono i file all'interno-hanno il
prefisso “IMG_"seguito da un numero, lo stesso visto in precedenza sul display della fotocamera in sede
di riesame delle foto. Un solo clic su un file mostra una piccola immagine di anteprima.

5. Fare clic su “Modifica>Seleziona tutte” (oppure fare clic su una foto, control+clic per selezionare pitt
foto), quindi “Modifica>Copia su cartella” (nei menu di Windows). Selezionare una cartella esistente sul
disco rigido, quale “’Mie foto”, oppure creare una nuova cartella (“Vacanze alle Hawaii, ecc.), quindi fare
clic su “OK” per trasferire le copie deifile delle foto preferite.

6. Dopo che le foto sono state trasferite sul disco rigido, ¢ possibile scollegare la fotocamera. Windows
2000 potrebbe produrre una schermata avvertendo che un dispositivo USB ¢ stato scollegato prima
che un “disco” sia stato fermato o espulso (i file delle foto non subiranno alcun danno). In questo caso,
selezionare la casella che aggiunge un’icona alla system tray o alla barra delle applicazioni. La prossima
volta che si ¢ finito di trasferire altre foto, prima di scollegare la fotocamera, ¢ possibile fare clic su
quest’icona e selezionare “Ferma il dispositivo di memoria di massa USB” (nei computer Mac, “espellere”
il “disco” che ¢ apparso sul desktop quando ¢ stata collegata la fotocamera).
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Trasferimento di foto e video al PC

7. E possibile adesso aprire i file delle foto usando qualsiasi programma di elaborazione delle immagini. Selezionare
File>Apri ¢ andare alla cartella dove sono stati gid salvati i file delle foto. Se viene usato PhotoSuite, selezionare
File>Apri foto, quindi usare il menu a discesa “Cerca in” in alto sulla finestra Apri, selezionare “Esplora risorse”,
selezionare il disco rigido e fare doppio clic sulla foto nella cartella dove sono stati copiati i file dalla fotocamera.
E anche possibile aprire ¢ lavorare sulle foto direttamente da ImageView mentre & ancora collegata: Per fare questo
con PhotoSuite, innanzitutto seguire i passi 1-3, quindi aprire PhotoSuite, selezionare File>Apri foto e usare il menu
“Cerca in” per selezionare Esplora risorse, quindi selezionare “Disco rimovibile”, ¢ aprire le cartelle fino a quando si
trovano i file JPEG delle foto. Se si decide di procedere in questo modo, da una fotocamera collegata, accertarsi di
salvare le foto (dopo aver terminato I'editing) sul disco rigido, anziché nella memoria o nella card della fotocamera.
Per fare questo in PhotoSuite, dopo aver fatto clic su “Fatto”, rispondere a “Salva Modifiche?” con “Si”, ma poi
rispondere a “Sostituire file esistente”? con “No” e usare la finestra di dialogo “Salva con nome” per salvare la foto
modificata in una cartella del disco rigido (“Salva In>Disco locale”), non il “Disco rimovibile” (fotocamera).

8. Se non si ha molta pratica con i programmi di foto editing al computer, consultare il menu Guida del software
(PhotoSuite ha un'ampia Guida incorporata) per consigli su come usare le funzioni del programma. Oltre a regolare
la luminosity, il contrasto, la nitidezza ¢ il colore delle foto, & possibile ridimensionare la foto per adattarla alla carta
sulla quale stampare la foto, oppure salvare una versione con risoluzione minore, bassa, o media per allegare la foto ad
un’email o per inserirla in un documento. Quando si ¢ pronti a salvare il file modificato, ¢ possibile usare “Salva con
nome” e dare al file un nome piti descrittivo di “IMG__". Agendo in tal modo, il file originale viene conservato come
file di riserva da aprire e modificare di nuovo in un secondo momento. Prima di selezionare “Cancella tutte” nella
fotocamera, per lasciare spazio a nuove immagini, accertarsi di aver trasferito tutte le foto che si volevano salvare.
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ISTRUZIONI PER L'USO DEL BINOCOLO

1l binocolo Bushnell & uno strumento di precisione, costruito per durare anni e anni. Le sezioni che
seguono spiegano come regolare il binocolo per adattarlo agli occhi e come averne cura. Leggere
attentamente le istruzioni prima di usare il binocolo, per ottenere i migliori risultati possibili.

REGOLAZIONI PER L'ADATTAMENTO AGLI OCCHI (Figura 1)
Regolazione della distanza interpupillare
La distanza interpupillare ¢ la distanza tra i punti centrali delle pupille
e varia da una persona all’altra. Per allineare gli oculari del binocolo agli
occhi, procedere come segue.

1. Tenere il binocolo nella normale posizione di osservazione.

2. Mantenendo una presa salda sui due barilotti, avvicinarli I'uno all’altro
o allontanarli finché il campo visivo, circolare, non diventa unico.
Riportare sempre il binocolo su questa posizione prima di usarlo.

[DISTANZA INTERPUPILLARE

Regolazione diottrica
Ogni persona ha una capacita visiva diversa; la maggior parte dei binocoli Bushnell ¢ dotata di anelli

per la regolazione diottrica, che permettono di regolare la convergenza del sistema ottico secondo la
propria capacita visiva. Procedere come segue.
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MESSA A FUOCO

1. Regolare la distanza interpupillare (Figura 1).

2. Portare su zero I'anello di regolazione diottrica (Figura 2) e osservare un
oggetto lontano.

3. Mantenere sempre aperti entrambi gli occhi.

4. Coprire con un coperchietto o una mano l'obiettivo (lente frontale)
dello stesso barilotto su cui si trova I'anello di regolazione diottrica (in
genere il barilotto destro; quello sinistro per i modelli con zoom).

5. Girare la ghiera centrale di messa a fuoco finché un oggetto distante che presenti dettagli minuti (p.
es. un muro di mattoni, i rami di un albero) appaia con la massima nitidezza possibile.

6. Scoprire l'obiettivo sul lato dell’anello di regolazione diottrica, coprire I'altro obiettivo e osservare lo
stesso oggetto.

7. Girare I'anello di regolazione diottrica per mettere a fuoco 'oggetto osservato. Fare attenzione a non

REGOLAZIONE DIOTTRICA

girare eccessivamente I'anello, poiché forzandolo si pud danneggiarlo o si puo causare il distacco
dell'oculare dal barilotto.

8. Regolare il binocolo in modo da adattarlo ai propri occhi. Per metterlo a fuoco basta girare 'apposita
ghiera centrale. Prendere nota della posizione ottimale dell’anello di regolazione diottrica.

BORDI DEGLI OCULARI (Figura 3)

Gli oculari del binocolo sono dotati di bordi di gomma rovesciabili, studiati
per aderire meglio e riparare dalla luce esterna. Se portate occhiali, sia da
vista che da sole, ripiegate questi bordi per avvicinare gli oculari agli occhi e
migliorare quindi il campo visivo. ROLL-DOWN EYECUPS
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COME AVERE CURA DEL BINOCOLO

Ogni binocolo Bushnell assicura anni e anni di servizio senza problemi purché se ne abbia la stessa
cura che si dedicherebbe a qualsiasi strumento ottico di precisione. ImageView non ¢ impermeabile
e non va esposto a un’'umiditd eccessiva. I danni causati dall’acqua non sono coperti dalla garanzia.

1. Se gli oculari hanno bordi flessibili rovesciabili, riportarli in posizione estesa prima di riporre il
binocolo, per evitare che siano sottoposti a inutili sollecitazioni prolungate e che si usurino.

2. Evitare urti al binocolo e fare attenzione a non farlo cadere.

3. Riporre il binocolo in un luogo fresco e asciutto.

4. AVVERTENZA: non osservare mai direttamente il sole attraverso il binocolo, poiché si possono
subire gravi lesioni, compresa la perdita della vista.

5. Non esporre mai il binocolo a quantita eccessive di un liquido di qualsiasi natura, poiché il binocolo
non ¢ impermeabile all’acqua o all'umidita della nebbia.

6. Se il binocolo non verrd usato per un lungo periodo di tempo, estrarre le pile dalla fotocamera
(accertarsi prima che tutte le foto memorizzate siano state scaricate).

PULIZIA

1. Spolverare le lenti soffiandovi (o adoperare un pennellino morbido per lenti).

2. DPer ripulire le lenti dallo sporco o da impronte digitali, adoperare un panno di cotone morbido,
passandolo con movimenti circolari. Utilizzando un panno ruvido o strofinando eccessivamente
si possono graffiare le lenti e anche danneggiarle irreversibilmente. Per la pulizia ordinaria delle
lenti ¢ ideale un panno apposito in microfibre, reperibile nella maggior parte dei negozi di articoli
fotografici.

3. Per una pulizia pilt accurata si possono usare salviette per lenti e un detergente apposito o alcol

isopropilico. Applicare sempre il liquido alla salvietta, mai direttamente alle lenti.
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GARANZIA LIMITATA PER DUE ANNI

Si garantisce che questo prodotto Bushnell® sara esente da difetti di materiale e
fabbricazione per due anni a decorrere dalla data di acquisto. In caso di difetto durante
il periodo di garanzia, a nostra discrezione ripareremo o sostituiremo il prodotto
purché sia restituito franco destinatario. Sono esclusi dalla garanzia eventuali danni
causati da abuso, maneggiamento improprio, installazione o manutenzione eseguiti da
persone non autorizzate dal servizio di assistenza Bushnell.

A un prodotto restituito e coperto da questa garanzia occorre allegare quanto segue.

1) Assegno/ordine di pagamento per l'importo di 10 $US per coprire i costi di
spedizione.

2) Nome e indirizzo da utilizzare per la restituzione del prodotto.

3) Una spiegazione del difetto.

4) Scontrino riportante la data di acquisto.

5) 1l prodotto deve essere imballato in una scatola robusta, per prevenire danni
durante il trasporto, e va spedito franco destinatario a uno dei seguenti
indirizzi.

Recapito negli Stati Uniti: ~ Recapito in Canada:

Bushnell Outdoor Products Bushnell Performance Optics
Attn.: Repairs Attn.: Repairs

8500 Marshall Drive 25A East Pearce Street, Unit 1
Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

Per prodotti acquistati fuori degli Stati Uniti o del Canada, rivolgersi al rivenditore per
le clausole pertinenti della garanzia. In Europa si puo anche contattare la Bushnell a
questo numero: BUSHNELL Performance Optics Gmbh

European Service Centre

MORSESTRASSE 4

D- 50769 - Cologne

Germania

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Questa garanzia da specifici diritti legali.
Eventuali altri diritti variano da una nazione all’altra.
©2006 Bushnell Outdoor Products

Dichiarazione relativa alla iva FCC (Federall
Communications Commission)

In base alle prove eseguite su questo apparecchio,|
se ne ¢ determinata la conformita ai limiti relativi ail
dispositivi digitali di Classe B, secondo la Parte 15 delle|
norme FCC. Tali limiti sono stati concepiti per forniref
una protezione adeguata da interferenze pericolosef
in ambiente domestico. Questo apparecchio genera,|
utilizza e puo irradiare energia a radiofrequenza e, sef
non installato e utilizzato secondo le istruzioni, pud
causare interferenze dannose per le comunicazioni
radio. Tuttavia, non esiste alcuna garanzia che, in uno|
specifico impianto, non si verificheranno interferenze.|
Se questoapp hio causasse inter d per|
la ricezione dei segnali radio o televisivi, determinabil
spegnendolo e riaccendendolo, si consiglia di tentare dif
rimediare all'interferenza con uno o piti dei seguenti
metodi.

- Cambiare lorientamento dellantenna ricevente of
spostarla.

- Aumentare la distanza tra lapparecchio e il ricevitore.
- Collegare lapparecchio a una presa inserita in unf
circuito diverso da quello a cui & collegato il ricevitore.
- Rivolgersi al rivenditore 0 a un tecnico radio/TV|
qualificato.

Per soddisfare la conformita di questo apparecchio ail
limiti relativi ai dispositivi digitali di Classe B, secondo
la Parte 15 delle norme FCC occorre adoperare con esso|
un cavo di interfaccia schermato.

I dati tecnici e progettuali sono soggetti a modifiche|
senza preavviso o obbligo da parte del produttore.

€
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AVISO

Verifique se fez o download das imagens de sua cAmera ANTES de remover
ou trocar as pilhas, a menos que vocé tenha usado um cartio SD em vez da
memoria interna para o armazenamento das fotografias. E recomendével fazer o
download de todos os arquivos de fotografias atuais para manté-los seguros antes
de armazenar o ImageView se nio estiver usando um cartio SD na cimera, caso
as pilhas descarreguem durante o armazenamento maior.

AVISO

NAO olhe diretamente para o sol com os binéculos.
Pois isso poderd causar danos permanentes aos seus olhos.

NOTA: Para reconfigurar a cimera se houver problemas ou se o display néo estiver
respondendo, remova as pilhas por pelo menos um minuto e, em seguida, reinstaleas.
Isso poderd resultar na perda de todas as fotografias/videos armazenados na
memoria interna.
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PORTUGUES

Parabéns por sua aquisi¢io do binéculo ImageView® da Bushnell! O
binéculo ImageView da Bushnell tem a tecnologia da fotografia digital
e a combina com um binéculo compacto de alta qualidade. Isso permite
a vocé observar eventos esportivos, vida selvagem, vistas panorimicas
ou qualquer outra observagio para a qual vocé normalmente usaria
o binéculo, e depois salvar a imagem em uma cimera digital anexa
embutida. Em seguida, vocé poderd fazer o download dessas imagens
para o seu computador e envid-las por e-mail para amigos e familia,
imprimir a imagem usando o software incluido ou salvé-las em um
dlbum de fotografias para uso futuro. Antes de usar o produto, leia
as instrugées contidas neste manual e familiarize-se com os diferentes

recursos e pecas do produto.
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Guia de pegas do binéculo
e da cAmera

Conector ~ Slot para Porta
remoto cartio USB

Soquete
do tripé

Compartimento

\

Foco do Botio Botio das pilhas
binéculo Snap Lente da de (Para abrir, deslize
cAmera  modo y na direio da seta)
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Configuragio e operagao basica
1.A cAmera funciona com duas pilhas AAA alcalinas, litio ou NiMh (ndo incluidas). Insira as pilhas

no compartimento, com as molas em contato com a extremidade negativa (plana) de cada pilha. Um
medidor de energia & esquerda do centro do display indica a condigio da pilha.

2. Insira um cartao SD ("de cabega para baixo" com os contatos de metal para cima) no slot se desejar maior
armazenamento. Vocé pode usar cartdes SD (ndo cartoes MMC) até 1 GB de capacidade. A cimera possui
8 MB de meméria interna que pode armazenar mais de 100 fotograﬁas, por isso o cartdo nio é necessrio.
Porém, o contetido da meméria interna serd perdido se as pilhas forem removidas ou descarregarem, diferente
de fotografias armazenadas em um cartdo de meméria SD. Um cartio de velocidade padrio de 256 MB
estd disponivel na maioria das lojas de computadores ou produtos eletrénicos e é uma boa escolha para o
seu ImageView.

3. Pressione e mantenha pressionado o botio de MODO até que a cimera ligue. A cAmera desligard
automaticamente apés um minuto se nenhum botao for pressionado. Nota: quando a cimera estiver
conectada a um computador via o cabo USB fornecido, a cimera ligard automaticamente e a energia serd
fornecida pelo computador sem gasto de pilhas.

4. Mantenha o ImageView firme e pressione SNAP para tirar uma fotografia (ou iniciar/parar de filmar um
video quando a cAmera estiver no modo de video). O foco da cimera estd predefinido para tirar fotos nitidas
de aproximadamente 35 pés (10, 67 m) ao infinito.

5. Ao usar um tripé, vocé pode ajudar a evitar os efeitos da vibragio da cimera conectando o disparador
remoto fornecido no conector préximo ao slot de cartao SD e usando o botao no remoto em vez do SNAP
para tirar fotografias.
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Usando os modos operacionais/configurando a data e a hora
O ImageView ird imprimir a data e a hora no canto inferior direito das fotografias. Para definir
a data e hora atual, ap6s ligar a cAmera, pressione ¢ mantenha pressionado ambos os botées
de MODO e SNAP ao mesmo tempo, até que o display comece a piscar. O display agora
mostra os dois tltimos digitos do ano. Pressione o botio de MODO até mover o cursor para o
segundo digito se necessdrio. Pressione o botdo SNAP para avancar o digito ao ano atual ("07"
para 2007, etc). Em seguida, pressione o botio de MODO para ir até o préximo niimero,
que é o més. Novamente, use SNAP para alterar esse nimero ao més atual. Apés a exibigio
do més estd: data e hora (formato de 24 horas), minuto e segundo-continue a definir essas
opcoes usando o mesmo processo através dos botées de MODO e SNAP. Apds completar
todos os ajustes de data/hora, o display nao mais piscard e voltard ao normal. Observe que serd
necessério redefinir a data/hora apés substituir as pilhas.

O ImageView ja vem configurado de fibrica para alta resolugio e qualidade, e ndo é necessdrio
usar as definicoes de MODO e fazer alteragoes. Para obter bons resultados, simplesmente
pressione o botdo SNAP para tirar fotografias. Porém, se vocé descjar filmar um clipe de video,
excluir uma ou mais fotografias anteriores ou explorar outras op¢oes, ¢ recomenddvel revisar as
opgoes de modo disponiveis relacionadas nas pdginas seguintes. Pressionar brevemente o botao
de MODO ird passar por esses modos operacionais na ordem listada e vocé ver4 o icone para
cada modo junto com as configuragdes atuais no display. Use o botao SNAP para selecionar
a configuragio desejada para qualquer modo. Se vocé nao fizer alteragoes, e o botao SNAP ou
MODO nao estiver pressionado em 5 segundos, a cAmera retornard ao display e 4 operagio
normal.
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Usando os modos operacionais (Negrito indica as configuracdes padrao)

pixels), Baixa

(320x240 pixels)

Modo Icone Configuragées | Descrigao

Video Video OFF (DES- Selecione a resolugao de video "Hi" (recomendédvel)
Camera LIGADO), Alta ou "Lo" em vez de "OFF" para colocar a cAmera
(640x480 pixels no modo de video. Espere alguns segundos para
por quadro, 15 a cAmera retornar automaticamente ao display
fps (quadros por normal. Em seguida, comece a filmar pressionando
segundo)), Baixa SNAP. O contador comegard a mostrar o tempo
(320x240 pixels) decorrido até o miximo de segundos de 53 (Hi)
ou 132 (Lo) para cada clipe de video. Pressione
SNAP novamente para parar de filmar. O contador
avancard um, indicando que o arquivo de video foi
salvo. Retorne a configuragio de modo de video e
selecione OFF (DESLIGADO) para redefinir a

camera para o modo de fotografia still.

Qualidade Hqou Lq Alta, Baixa Selecione a qualidade "Hi" (recomendével) ou
"Lo" para escolher a quantidade de compactagio
do arquivo, que afeta o tamanho do arquivo de
fotografia. "Lo" permite que mais fotografias sejam
armazenadas na memoéria, mas com qualidade
reduzida.

Resolugio Hi ou Lo Alta (640x480 Selecione a resolugio "Hi" (recomenddvel) ou "Lo",

com base na sua preferéncia para tirar fotografias
melhores (Hi) ou para tirar um nimero maior de
fotografias (Lo).
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Usando os modos operacionais

a tltima fotografia
ou video

Modo Icone Configuragées | Descrigao
Fregiiéncia de 60 ou 50 60 Hz, 50 Hz Configure para que corresponda a freqiiéncia de
linha energia CA (ciclos) do seu pais. Isso garante que
as fotografias still e os videos filmados sob luz
fluorescente aparecam normais.
Continua CT OFF, 3, 5 Selecione 3 ou 5 quadros para tirar uma série ripida
de fotografias em vez de um tnico quadro quando
SNAP for pressionado (no modo de fotografia still
normal). Para cancelar, entre nesse modo novamente
e selecione OFF.
Acesso a MEM Sto Selecione "Sto" para acessar a meméria interna ou
meméria (Armazenamento do cartdao quando a ciAmera estiver conectada a um
em massa USB), computador com o cabo USB. "PC" permite que a
PC (Camera USB) | cimera seja usada como uma ciAmera USB/PC ativa
(observe que a ampliagdo 8x e a falta da capacidade
de proximidade de foco limita a utilidade na maioria
dos aposentos)
Excluir tltima LSt+Trash Nenhum-pressione | Selecione esse modo e pressione SNAP para excluir
Can SNAP para excluir | somente a tltima fotografia ou video que vocé tirou.

O contador baixard um nimero.
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Usando os modos operacionais

automdtico

ou On (Ligado)

Modo Icone Configuragées | Descrigao
Excluir todas ALL+Trash Nenhum-pressione | Selecione esse modo e pressione SNAP para
Can SNAP para excluir todo o contetido da meméria (o contador é
excluir todos os redefinido para zero). Use isso apés fazer o download
arquivos de video e | de seus arquivos, para limpar a meméria para que
fotografias vocé possa tirar novas fotografias. Se "Excluir todas"
for selecionado acidentalmente, simplesmente
aguarde alguns segundos e a cimera retornard a
operagio normal.
Formatar FOr+Trash Nenhum- Se vocé estiver usando um novo cartao SD ou um
Can pressione SNAP previamente usado em outros dispositivos, serd
para formatar a recomendadvel que vocé selecione Format (Formatar)
memoria interna e pressione SNAP antes de comegar a tirar
ou do cartio fotografias, para que o cartdo seja configurado com
o sistema de arquivos de dados corretos para essa
camera. Observe que formatar um cartio ird apagar
seu conteiido-certifique-se de que fez o backup de
quaisq ivos anteriores primeiro.
Cronémetro Relégio OFF (Desligado) A fotografia ¢ tirada apés um atraso de 10 segundos

quando SNAP ¢ pressionado  (no modo de
fotografia still normal). Isso pode ser usado para
evitar de acidentalmente sacudir a cAmera quando
o botio SNAP for pressionado. Se o cabo do
obturador remoto estiver disponivel, ele deverd ser
usado em vez do crondémetro automidtico quando a
cAmera estiver montada no tripé. O cronémetro é
cancelado automaticamente ap6s o uso.
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USANDO O IMAGEVIEW COM O COMPUTA

1. A chmera serd reconhecida como um dispositivo de armazenamento em massa USB (se estiver
definida para "STO" e nio "PC"), o que significa que ndo é necessirio nenhum driver especial
para todos os sistemas operacionais superiores a0 Windows 98 (ME, 2000, XP). Mac OS 9 e
OSX também sio compativeis. Se vocé tiver um PC com o Windows 98, deverd instalar o driver
encontrado no CD-ROM incluido ANTES DE CONECTAR A CAMERA AO PC.

2. Se vocé tiver um SO de computador como relacionado acima que ¢ compativel com o armazenamento
em massa USB, um novo icone de disco serd exibido no Windows Explorer (sob “Meu computador”)
como um novo “Disco removivel” apds conectar o cabo USB a partir do Imageview. Os usudrios do
Mac verdo o novo dispositivo de disco exibido na drea de trabalho.

Clicar no icone do novo disco mostrard o conteido, uma pasta chamada “DCIM”. A pasta de
imagem dentro dela contém suas fotografias, armazenadas como JPEGs (formato de arquivo .jpg).
Elas podem ser abertas, editadas, renomeadas e salvas usando qualquer software de fotografia ou
grificos que aceita arquivos .jpg. Se vocé ndo tiver um software que abre arquivos .jpg, deverd instalar
o MGI Photosuite (somente para Windows) a partir do CD-ROM incluido. Consulte “Instalagio
do software” para obter instrugoes.

3. Apos ter copiado e salvo os arquivos de fotografias para o disco rigido do computador, vocé poderd
desconectar a cimera Imageview (NUNCA desconecte a cimera enquanto os arquivos ainda estao
sendo transferidos para o computador). Antes de desconectar, vocé deve “cjetar” ou parar o disco
removivel representando a cimera para evitar uma mensagem de erro (nio ¢ necessirio com o
Windows XP).

4. Consulte as pdginas seguintes para obter as instrucdes passo a passo completas para fazer o download
dos arquivos.
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Requisitos do sistema (Minimo)

SO: Windows® 98/98SE/2000/ME/XP

CPU: MMX Pentium® 200MHZ equivalente ou mais rdpido (Pentium® III 500 MHz para PhotoSuite5™)
Meméria: 32 MB minimo (64 MB recomendavel para PhotoSuite)

placa de video SVGA com 2 MB VRAM, exibigio de tela 800x600, High color (16 bits)

200 MB de espaco em disco rigido disponivel (se estiver instalando o PhotoSuite)

Porta USB interna

Instalacio do software

Se vocé estiver usando o Windows 98, deverd instalar os drivers antes de conectar a cimera ao PC. Insira 0 CD-ROM
na unidade de CD do computador; ele serd executado automaticamente ¢ a tela de instalagio serd exibida. Selecione
“Instalar driver” e siga as instrugoes. Apds a instalacdo, reinicie o computador. O Windows 2000, ME, ¢ XP nio exi-
gem drivers, pois a cAmera usa o padrio de armazenamento em massa USB, permitindo que os arquivos de fotografias
sejam acessados mesmo se estiverem armazenados em um disco rigido externo. Para qualquer SO Windows, se vocé
ainda ndo estiver usando o software de edicio de fotografias desejado, poderd instalar o Roxio PhotoSuite” a partir
do CD-ROM. Leia as “Notas de versao” completamente, observando quaisquer dicas ou problemas em potencial
relevantes para o SO e a configuragio do PC.

AVISO: Verifique se fez o download de qualquer
imagem da camera antes de remover as pilhas da camera.

Transferindo as fotografias e os videos para o PC - Passo a passo
1. Verifique se o driver foi instalado primeiro se vocé estiver no Windows 98/98SE.
2. Conecte o cabo fornecido & porta USB do ImageView, em seguida, diretamente a uma porta USB principal no
computador-nio use as portas USB do teclado/painel frontal ou “hubs” sem energia.

93



Transferindo as fotografias e os videos para o PC - Passo a passo
3. O display LCD ird indicar “STO” e o ImageView serd reconhecido como um dispositivo padrio
de “Armazenamento em massa USB”. Isso significa que os arquivos da cAmera podem ser facilmente

exibidos, editados ou copiados para o seu disco rigido, como se estivessem armazenados em um disco
rigido externo ou um CD-ROM.

4. (Essa etapa nio ¢ necessdria com o Windows XP, simplesmente use as opg¢oes na janela instantinea para
exibir, copiar ou editar suas fotografias). Abra Meu computador ou o Windows Explorer. A cAmera serd
exibida como um novo “Disco removivel” com uma letra de unidade nao usada atribuida a ela. Clique
duas vezes nesse novo icone “Disco”, abra a pasta “DCIM” no interior, em seguida a(s) pasta(s) dentro
dela (“100MEDIA”, etc). As fotografias/videos sdo os arquivos no interior-elas tém o prefixo “IMG_
” seguido por um niimero, como visto anteriormente no display da cAmera quando vocé revisar as
fotografias. Clicar uma vez em qualquer arquivo deverd mostrar uma pequena imagem de visualizagio.

5. Clique em “Editar>Selecionar todas” (ou clique em uma fotografia, control+click para selecionar
vérias fotografias), e “Editar>Copiar para pasta” (nos menus do Windows). Selecione uma pasta existente

no disco rigido como “Minhas imagens”, ou crie uma nova pasta (“Férias no Havai”, etc), e clique em
“OK” para transferir as cépias dos arquivos de fotografias desejados.

6. Apés as fotografias terem sido transferidas para o disco rigido, vocé poderd desconectar a cAmera.
O Windows 2000 talvez produza uma tela avisando que vocé desconectou um dispositivo USB sem
parar ou ejetar o “disco” primeiro (seus arquivos de fotografias nio serio danificados). Se isso ocorrer,
marque a caixa que adiciona um icone a bandeja do sistema ou barra de tarefas. Na préxima vez em que
vocé terminar de transferir as fotografias, poderd clicar nesse icone primeiro e “Parar o dispositivo de
armazenamento em massa USB” antes de desconectar a cAmera. (Em computadores Mac, vocé deve
“ejetar” o “disco” que aparecer na 4rea de trabalho quando a cimera foi conectada.)
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Transferindo as fotografias e os videos para o PC - Passo a passo

7. Agora vocé estd pronto para abrir os arquivos de fotografias em qualquer software de edigio de fotografias. Use
Arquivo>Abrir ¢ v4 para a pasta em que armazenou as fotografias anteriormente. Se vocé estiver usando o PhotoSuite,
selecione Arquivo>Abrir fotografia, ¢ use o menu suspenso “Examinar” no topo da janela Abrir, selecione “Meu
computador”, selecione o disco rigido ¢ clique duas vezes em qualquer fotografia na pasta em que copiou os arquivos
da cimera. Também ¢ possivel abrir ¢ trabalhar com as fotografias diretamente do ImageView enquanto ainda estd
conectado. Para fazer isso com o PhotoSuite, primeiro siga as etapas 1-3, em seguida, abra o PhotoSuite, selecione
Arquivo>Abrir fotografia ¢ use 0 menu “Examinar” para selecionar Meu computador e selecione “Disco removivel”,
¢ abra as pastas até que vocé chegue nos arquivos de fotografias JPEG. Se vocé escolher trabalhar desta forma, de uma
cimera conectada, verifique se salvou a fotografia (quando terminar de editar) no disco rigido ¢ ndo no cartio ou na
memoria da cAmera. Para fazer isso no PhotoSuite, apés clicar em “Concluido”, responda “Salvar alteragdes?” com
“Sim”, mas em seguida responda “Substituir arquivo existente” com “Nao” ¢ use a caixa de didlogo “Salvar como”
para salvar a fotografia editada em uma pasta no disco rigido (“Salvar em>Disco local”), ndo o “Disco removivel”
(cAmera).

8. Se vocé ndo tem experiéncia com edigio de fotografias no computador, consulte 0 menu de Ajuda do software
(o PhotoSuite tem uma Ajuda interna abrangente) para obter dicas sobre como usar os seus recursos. Junto com o
ajuste de brilho, contraste, nitidez ¢ cor das fotografias, vocé poderé redimensionar a fotografia para caber no papel
se estiver imprimindo, ou salvar uma versio de resolugio média, baixa ou menor para enviar por e-mail ou inserir em
documentos. Quando vocé estiver pronto para salvar o arquivo editado, talvez deseje usar “Salvar como” ¢ fornecer
a ele um nome mais descritivo do que “IMG___". Fazer isso também preserva o arquivo original como backup para
abrir ¢ editar novamente mais tarde. Verifique se transferiu com éxito todas as fotografias que descjava salvar antes de
usar “Excluir todas” na cimera para criar mais espago para as novas imagens.
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INSTRUCOES DO BINOCU

O seu binéculo Bushnell ¢ um instrumento de precisao projetado para proporcionar vdrios anos de
observagio prazerosa. Essa parte do livreto o ajudard a obter desempenho superior explicando como
vocé pode ajustar o bindculo aos seus olhos e como cuidar deste instrumento. Leia as instrugoes
com cuidado antes de usar o bindculo.

AJUSTE PARA OS OLHOS (Figura 1)

Como ajustar a distancia entre os olhos
A distancia entre os olhos, chamada de “distincia interpupilar”, varia de
pessoa a pessoa. Para obter o alinhamento perfeito entre as lentes e os

olhos, siga €ssas etapas simples. DISTANCIA INTERPUPILAR

1. Mantenha o binéculo na posi¢ao normal de observagio.

2. Segure cada cilindro com firmeza. Aproxime ou afaste os cilindros até
enxergar somente um tnico campo circular. Sempre reajuste o bindculo para esta posi¢ao antes de
usé-lo.

Como ajustar para a sua visdo
Como a visdo varia de uma pessoa para outra, a maioria dos binéculos Bushnell apresenta um recurso de

ajuste de dioptria que permite ajustar o binéculo 2 sua visdo. Siga as instrugdes de focalizacao abaixo
para o seu tipo de bindculo.
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FOCALIZACAO

1. Ajuste a distincia interpupilar. (Figura 1)

2. Coloque o “ajuste de dioptria” (Figura 2) na posigio zero e visualize um
objeto distante.

3. Mantenha ambos os olhos sempre abertos.

4. Usando a tampa da lente ou sua mio, cubra a lente da objetiva (frente) do

AJUSTE DE DI( DPTRIA

mesmo lado do binéculo que possui o “ajuste de dioptria”. Geralmente é o
lado direito. (O lado esquerdo em modelos com zoom.)

5. Usando o disco de focalizagao central, focalize um objeto distante com detalhes precisos

(por exemplo, uma parede de tijolos, galhos de drvore, etc.) até que a imagem fique tio nitida quanto
possivel.

6. Descubra a lente objetiva do lado da dioptria e cubra a lente objetiva do outro lado. Em seguida,
visualize 0 mesmo objeto.

7. Usando o anel de ajuste do “ajuste da dioptria”, focalize 0 mesmo objeto sendo visualizado. Tenha
cuidado para nio girar muito nem forcar a ocular de dioptria, pois isso poderd causar danos ou fazer
com que a ocular se destaque do chassi.

8. O seu binéculo deve estar ajustado aos seus olhos. Agora, qualquer distancia poderd ser focalizada,
bastando girar o disco de focalizagao central. Anote o ajuste de dioptria para seus olhos para uso
futuro.

VISEIRAS (Figura 3)

O binéculo Bushnell possui viseiras de borracha dobraveis projetadas para

o seu conforto e para eliminar a luz externa supérflua. Se vocé usar éculos ou
6culos de sol, abaixe as viseiras. Isso fard com que seus olhos se aproximem da
lente do binéculo, melhorando assim o campo de visao.
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INSTRUCOES DE CUIDADO DOS BINOCULOS
O seu binéculo Bushnell proporcionard vdrios anos de servico sem problemas se receber os cuidados
usuais que devem ser dados a qualquer instrumento 6ptico delicado. O Imageview nio ¢ & prova
d'4gua e ndo deve ser exposto a qualquer fonte de umidade. Os danos por dgua nao sao cobertos pela
garantia.

1. Se o seu binéculo tem viseiras flexiveis, dobréveis, armazene-o com as viseiras para cima. Isso evitard
tensdo e gasto excessivos nas viseiras na posi¢io para baixo.

2. Evite esbarrar no binéculo ou deixi-lo cair.

3. Armazene em local seco e fresco.

4. AVISO: Olhar diretamente para o sol com o binéculo pode causar danos permanentes aos olhos.

5. Nunca exponha o binéculo ImageView a qualquer tipo de fluido ou liquido excessivo, pois ele nio é
a prova d’dguanem de embagamento.

6. Retire as pilhas do ImageView se ndo for usi-lo por um longo periodo de tempo. (Verifique se vocé fez
o download de quaisquer imagens da cAmera antes de remover as pilhas da cimera.)

LIMPEZA

1. Sopre toda a sujeira ou detritos nas lentes (ou use uma escova para lentes macia).

2. Para retirar a sujeira ou impressoes digitais, limpe com um tecido de algodao macio, usando movimento
circular. A utilizagio de um pano 4spero ou o atrito desnecessirio poderd arranhar a superficie da
lente e causar danos permanentes. Um pano de limpeza de “microfibra” (disponivel na maioria dos
fornecedores de material fotografico) ¢ ideal para a limpeza rotineira dos materiais opticos.

3. Para uma limpeza mais profunda, pode-se usar lengos para lentes fotograficas e fluido de limpeza “tipo
fotogréfico” ou com 4lcool isopropilico. Coloque sempre o fluido sobre o pano de limpeza, nunca
diretamente sobre a lente.
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[GARANTIA LIMITADA DE DOIS ANOS

Garantimos que seu produto Bushnell® estard isento de defeitos materiais e de
fabricag@o. por dois anos ap6s a data de aquisi¢ao. Caso tenha algum um defeito sob
esta garantia, iremos a nossa op¢do, consertar ou trocar este produto desde que o
produto seja devolvido com porte pago. Esta garantia nao abrange danos causados por
uso indevido, operagao, instalagdo, ou manutengio incorretas efetuadas a no ser que
seja do Departamento do Servi¢o de Manutengao Autorizada da Bushnell.

Bushnell Outdoor Products
Attn.: Repairs

8500 Marshall Drive
Lenexa, Kansas 66214

Qualquer devolugio efetuada sob esta garantia deve incluir os itens relacionados

a seguir:

1) Um cheque/ordem de no de $10,00 para cobrir as
despesas de porte e gastos administrativos

2) Nome e endereco para a devolugio do produto

3) Uma explicagdo do defeito

4) Comprovante da Data de Aquisi¢ao

5) O produto deve ser cuidadosamente embalado, numa caixa de papeldo
resistente para prevenir danos enquanto em transito e enviado para os
enderegos indicados a seguir com porte de devolugio pago:

NOS EUA REMETER PARA: NO CANADA REMETER PARA:

Bushnell Performance Optics
Attn.: Repairs

25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

Para produtos adquiridos fora dos Estados Unidos ou do Canadi favor contatar seu
revendedor local quanto a informagdes aplicéveis referentes a sua garantia. A Bushnell
também pode ser contatada na Europa pelo telefone:

BUSHNELL Performance Optics Gmbh
European Service Centre
MORSESTRASSE 4

D- 50769 KOLN

Alemanha

Tél: +49 (0) 221 709 939 3

Fax: +49 (0) 221 709 939 8

Esta garantia lhe da direitos legais especificos.
Poderi ter outros direitos que podem variar de pais para pais.
©2006 Bushnell Outdoor Products

Nota da FCC:

Este equipamento foi testado e verificou-se que|
cumpre com os limites para um dispositivo digital
Classe B, de acordo com a Parte 15 das regras dal
FCC. Esses limites sio estabelecidos para oferecer|
protecoes adequadas contra a interferéncia prejudicial
em uma instalagio residencial. Este equipamentol
gera, usa e pode irradiar energia de radiofreqiiéncia
e, se ndo for instalado e usado de acordo com ag
instrugdes, poderd causar interferéncia prejudicial nas|
radiocomunicagoes. Entretanto, nao ha garantia de que]
ndo ocorrerio casos de interferéncia em determinadas
instalagdes. Se este equipamento causar interferéncial
prejudicial na recepcao de radio ou televisio (a qual
poderd ser determinada ligando-se e desligando-se o
equipamento), tente corrigir o problema adotando uma|
ou mais das medidas seguintes:

- Reoriente ou mude o lugar da antena receptora.

- Aumente a distancia entre o equipamento e receptor.

- Conecte 0 equipamento em uma tomada que faga parte def
um circuito diferente daquele onde o receptor se encontr:
conectado.

- Consulte um representante ou um técnico experiente em|
radio/televisdo para auxilio.

O cabo de interferéncia blindado deve ser usado com|
0 equipamento para cumprir os limites de dispositivol
digital segundo a Sub-parte B da Parte 15 das Regras|
da FCC.

Projetos e esp estdo sujeitos a
aviso prévio ou obrigagao por parte do fabricante.

€

sem|
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